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A. INTRODUCTION 

This Data Acquisition and Processing Report outlines the acquisition and processing 
procedures used for Hydrographic projects surveyed in 2012 by NOAA Ship Fairweather.  
Survey specific details will be listed in Descriptive Reports as needed.  Unless otherwise noted, 
the acquisition and processing procedures used and deliverables produced are in accordance 
with the NOAA Hydrographic Survey Specifications and Deliverables Manual (HSSD) April 
2012, the Field Procedures Manual (FPM), May 2012, and all active Hydrographic Surveys 
Technical Directives (HTD). 
 
Any additions and changes to the following will be included with the individual Descriptive 
Reports or by submission of an addendum. 
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B. EQUIPMENT 

Detailed descriptions of the equipment and systems, including hardware and software, used for 
bathymetric data acquisition, horizontal and vertical control operations, shoreline acquisition, 
and processing are listed below. 
 

1.0 Hardware 

The hardware listed in this section is used throughout the 2012 field season. 
 
1.1 Hardware Systems Inventory 

Detailed hardware information, including installation dates and serial numbers, is included in 
Appendix I of this report.  Manufacturer’s product specifications are maintained with reference 
documentation on board Fairweather. 
 
1.2 Echo Sounding Equipment 

Timing delays, ranging from 1 – 20 seconds in duration, have been identified in all 
Fairweather ship multibeam echosounder data following March 2012.  The timing issues 
appear to be related to deviations in the Hypack computer clock being utilized to timestamp the 
multibeam data instead of the POS MV. The exact causes of the timing offsets remain 
unresolved to date.  Additional entries have been made to the corresponding CARIS 
Hydrographic Vessel Files (HVFs) to mitigate the effects of the varying time delay for the 
Reson 7111 and 8160 data. 
 
1.2.1 Reson 7111 Multibeam Echosounder (MBES) 

Fairweather is equipped with a Reson 7111 MBES.  The system was upgraded from a Reson 
8111 in October 2009, which involved replacing the dry end transceiver and processor units 
but leaving the wet end hull-mounted projector and receiver intact.  The Reson 7111 is a 100 
kHz multibeam system with swath coverage of 150°.  The swath is made up of 301 discrete 
equidistant beams with an along-track and across-track beamwidth of 0.5°.  It has a specified 
depth range of 3 to 1200 meters, though the typical operational depth range of the Reson 7111 
on Fairweather is 20 to 300 meters.  No calibration information was provided by the 
manufacturer for the system.  However, since there are a limited number of systems in the 
world used for hydrography, we have worked with RESON and INFREMER regarding 
improvement with the sonar bottom detection algorithms.  Engineering quality receiver and 
transceiver boards were still in use during the 2012 field season until the new production level 
boards were installed during drydock in November 2012. No failures were experienced while 
operating under the engineering boards although spares were carried onboard.  
 
The Reson 7111 is hull-mounted within a reinforced projection that extends 27 inches below 
the keel.  It is located 39.5” starboard of the centerline at approximately frame 29 (see Figure 1 
& Figure 2). 
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Figure 1: RESON SeaBat 7111 MBES 

 
Figure 2: 7111 Installed on Fairweather
 

The unresolved timing offsets with the ship multibeam systems, described above, range less 
with the 7111 than with the Reson 8160.  With the offsets entered into the vessel HVF, any 
remaining data artifacts are well within allowable vertical and horizontal uncertainties for the 
corresponding depth ranges and are recommended for charting purposes.  
 
Unusually high uncertainty values were experienced in the outer 6 degrees of Reson 7111 data 
on either side of the swath this field season.  To avoid exceeding IHO Order 1 specifications 
for depths shoaler than 100 meters, these outer beams were rejected in post processing for all 
surveys.  Multibeam line spacing was tightened in these areas during acquisition to prevent the 
creation of holidays in the data.  
 
1.2.2 Reson 8160 Multibeam Echosounder (MBES) 

Fairweather is also equipped with a Reson SeaBat 8160 MBES with the snippet option.  The 
Reson 8160 is a 50 kHz multibeam system with swath coverage of greater than 4x water depth.  
Each swath is made up of 126 discrete beams with an along-track and across-track beamwidth 
of 1.5°.  Though the Reson 8160 on Fairweather has a specified depth range of 10 to 3000 
meters, the typical operational depth range is 300 to 1000 meters.  No calibration information 
was provided by the manufacturer of the system. 
 
The 8160 is hull-mounted within a reinforced projection that extends 13.6 inches below the 
keel.  It is located 54 inches port of the centerline at approximately frame 29 (see Figure 3 & 
Figure 4).   
 
Aside from the known data quality issues associated with the 8160, the unresolved timing 
offsets mentioned above ranged much larger with the 8160 than with the 7111 and data 
collected by the 8160 in not recommended for charting at this time.  
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Figure 3: Reson SeaBat 8160 MBES 

 
 
 
 
 
 
 
 
 
 
 
 
Figure 4: 8160 Installed on Fairweather 

 
1.2.3 Reson 7125 SV Multibeam Echosounder (MBES) 

Survey launches 2805 and 2808 are each equipped with a dual frequency Reson 7125 SV 
MBES.  The Reson 7125 SV has both a low frequency (200kHz) and high frequency (400kHz) 
transmit array with a swath coverage of 128°.  The swath is made up of 256 discrete beams for 
200 kHz and both 256 or 512 discrete beams for 400 kHz.  The typical operational depth 
ranges for the Reson 7125 SV operating at 200kHz is 3 to 400 meters and 3 to 100 meters 
operating with the 400kHz system.  Each system is hull mounted along the centerline and 
includes a single topside unit (see Figure 5 & Figure 6).  No calibration information was 
provided by the manufacturer for the systems; however, the unit installed on 2805 was tank 
calibrated for backscatter at the University of New Hampshire (UNH) during the winter of 
2011.  Preliminary calibration reports are forthcoming.  Research is ongoing for 7125 SV 
backscatter calibration.   

   
  

   Figure 5: Reson 7125 SV topside processor      Figure 6: Reson 7125 SV transducer arrays 
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1.2.4 Klein 5000 Side Scan Sonar (SSS) 

Fairweather utilizes both lightweight and heavyweight Klein Series 5000 sonar systems in 
addition to a Klein Series 5410 system operated without the bathymetry option.  Each system is 
comprised of a side scan sonar towfish, Transceiver and Processing Unit (TPU), specialized 
tow and data cables, and a Windows- based acquisition computer.  These systems operate at a 
nominal frequency of 500 kHz (455 kHz actual) and are rated to 200 meters depth.  Acquisition 
is conducted with Klein's SonarPro™ software and files are logged in SDF format.  Post 
processing occurs in CARIS SIPS. 
 
The towfish can be used as hull-mounted (Figure 7) or towed (Figure 8) by any of 
Fairweather’s launches or else towed from Fairweather (Figure 9).  In the hull-mounted 
configuration, the towfish is bolted to a sled on the bottom of the launch.  The sled is situated 
to port of the keel and is approximately centered fore and aft.  In the launch towed 
configuration, the lightweight Klein 5000 is towed by a CSW-6 portable electric winch on 
0.257 inch diameter cable.  In the towed configuration on Fairweather, the towfish can be 
fitted with a K-wing depressor and affixed to armored coaxial cable for deployment from 
Fairweather’s A-frame.  The amount of tow cable being used is automatically entered into 
SonarPro™ for towfish layback calculation for the Fairweather system and manually entered 
by the operator for the launch towed system.  In a towed configuration a side scan position 
certification check will be conducted and documented prior to data collection and system 
utilization.  Offsets and values used in the ship Klein 5000 HVF are included in the Offset 
spreadsheets included in Appendix II. 

 
Dual acquisition of Klein 5000 SSS and Reson 7125 or 7111 MBES data is the standard 
procedure with all side scan configurations.  The launch wiring diagrams are configured for 
Klein 5000 SSS and multibeam dual acquisition at all times.  Additionally, all Reson 7125 
MBES data acquired with hull mounted SSS data is filtered down to 45-degrees on either side.   
 

Figure 7: Hull-Mounted Klein 5000 Side Scan Sonar on Fairweather Launch with TPU 
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Figure 8: Launch-Towed Klein 5000 Side Scan Sonar 

 

 
Figure 9: Towed Klein 5000 Side Scan Sonar on Fairweather 

 
1.3 Manual Sounding Equipment  

1.3.1 Lead Lines 

Vessels are equipped with a lead line when appropriate.  Lead lines are used for depth 
measurements near shore over submerged shoals and for echosounder depth comparisons.   
 
Lead lines were created, measured and calibrated according to Section 1.5.3 of the FPM.  
Calibration was performed by Fairweather personnel on March 9, 2012, and documentation is 
maintained onboard.     
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1.4 Positioning, Heading, and Attitude Equipment 

1.4.1 Applanix Positioning and Orientation System for Marine Vehicles (POS MV) 

Fairweather and her launches are each equipped with a POS MV 320 V4, configured with 
TrueHeave™.  The POS MV calculates position, heading, attitude, and vertical displacement 
(heave) of a vessel.  It consists of a rack mounted POS Computer System (PCS), a strap down 
IMU-200 Inertial Measurement Unit (IMU), and two GNSS antennas corresponding to GNSS 
receivers in the PCS.  Fairweather (S220) and launches 2805 and 2808 are equipped with 
Zephyr II GNSS antennas.  Fairweather (S220) and launch 2805 are equipped with BD960 
PCS antenna receiver cards, and launch 2808 is equipped with BD950 PCS antenna receiver 
cards.  Both launch PCS units for 2805 and 2808 have also been upgraded for internal logging 
capabilities to eliminate packet drops across the acquisition network.  The port side antenna is 
designated as the primary receiver, and the starboard side antenna is the secondary receiver for 
all vessels (see Figure 9).  The POS MV firmware versions and the controller software versions 
that are currently installed are listed in the Hardware Inventory in Appendix I.  
 
For all multibeam systems aboard Fairweather and her launches, timing between the sonar 
swath, position, heading and attitude information was synchronized by utilizing the proprietary 
UTC string from POS MV.  A timing string is sent from the POS MV to the Reson topside unit 
via serial connection and to the Hypack acquisition computer via Ethernet.   
 
For the launch PCS units with internal logging capabilities, data is logged as small 12 MB files 
which are concatenated into a single .000 file. Files are concatenated through the NOAA in-
house tool “POSConcatenator” created by Grant Froelich of the Pacific Hydrographic Branch. 
 
POS MV controller software was used to monitor position accuracy and quality during data 
acquisition.  This ensured that positioning accuracy requirements are met, as outlined in section 
3 of the HSSD.  The POS MV controller software provides clear visual indications whenever 
accuracy thresholds are exceeded.  
 
1.4.2 POS MV GAMS Calibration 

In the spring of 2012, GNSS Azimuth Measurement System (GAMS) calibrations were 
performed on each of Fairweather’s three POS MV units mounted to launches 2805, 2808 
(Figure 10), and Fairweather (S220).  The GAMS calibration procedure was conducted in 
accordance with instructions in chapter 4 of the POS MV V4 User Guide, 2009.  Results and 
calibration reports are maintained with reference documentation aboard Fairweather.  Actual 
calibration dates are listed in the Hardware Inventory included in Appendix I. 
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Figure 10: POS GNSS Antennas 

 
1.4.3 DGPS Receivers 

Fairweather is equipped with a commercial grade CSI Wireless MBX-3S DGPS Receiver on 
Fairweather (S220) and Hemisphere GPS MBX-4 DGPS receivers on launches 2805 and 2808 
that are used to correct the POS MV GPS positions used during real-time MBES and SSS data 
acquisition.  The DGPS receivers are configured in manual mode to allow reception of only 
one U.S. Coast Guard (USCG) differential GPS beacon station at a time.   
 
Differential GPS (DGPS) is the primary method of real-time positioning.  The individual 
descriptive reports for each survey list the U.S. Coast Guard beacon sites and frequencies used 
for differential corrections utilized during hydrographic surveying. 
 
When Fairweather operates in remote areas outside of DGPS range, such as during Arctic 
projects, Fairweather and launch 2805 are equipped with POSMV PCS units with integrated 
DGPS.  These units are capable of receiving the satellite based augmentation systems (SBAS) 
such as WAAS for real-time decimeter position accuracy.  Launch 2808 is not equipped with 
one of these PCS units and runs in course acquisition mode (CA) during real-time data 
acquisition in these areas.  Horizontal position accuracies in CA mode range from 2-3 meters.  
The individual descriptive reports for each survey will indicate if WAAS correctors were 
utilized instead of DGPS. 
 
All individual vessel POSMV files from all platforms are post processed unless otherwise 
noted in respective survey Descriptive Reports and project Horizontal and Vertical Control 
Reports.   
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1.4.4 Trimble Backpack 

Fairweather uses two GPS Pathfinder® Pro XRS receivers in conjunction with a field 
computer to acquire detached positions during shoreline verification in the field.  Data can also 
be collected with a handheld TSCe data collector.  Field computers currently in use are 
Panasonic Toughbooks; two CF-30’s, one CF-29, one CF-19, and one CF-18’s.  The receivers 
have integrated DGPS beacon/satellite differential antennas which allow access to digital real-
time sub-meter accuracy solutions.  Data quality assurance testing was conducted by 
Fairweather personnel on March 20, 2012.  Trimble units (Figure 11) were tested over a 
published benchmark.  Trimble positions matched the published benchmark position within 
0.55m.  Test results are maintained with reference documentation on board Fairweather.  
 

 
Figure 11: Trimble Backpack Unit 

 
1.4.5 Hand-held Laser 

The Impulse Laser Rangefinder (Figure 12) and TruPulse 200 Laser Rangefinder (Figure 13) 
are used in conjunction with the Trimble Backpack GPS unit to acquire distances and heights 
during shoreline verification.  These data are entered directly into the shoreline acquisition 
software and annotated on the detached position forms.  The Impulse LR and TruPulse 200 
Laser Rangefinders do not function properly in low light or in choppy seas when a feature is 
not distinguishable from surroundings.  
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Figure 12: IMPULSE LR Laser 

Rangefinder 

 
Figure 13: TruPulse 200 Laser Rangefinder 

 
Data quality assurance testing was conducted on March 20, 2012 by Fairweather personnel.  
Vertical and horizontal readings were taken with the laser rangefinders and compared to 
measurements taken with a steel tape.  The laser rangefinder was set up on a tripod and a staff 
of known height was measured at distances of 10, 20, 50, and 100 meters.  Three horizontal 
and three vertical readings were taken at each interval with values only varying within +/- 
0.1m.  Detailed results of the laser rangefinder accuracy testing are maintained with reference 
documentation on board Fairweather. 
 
1.5 Sound Speed Equipment 

1.5.1 Sound Speed Profiles 

1.5.1.1 SBE 19plus SEACAT Profiler 

Fairweather is equipped with two SBE 19plus and two SBE 19plusV2 SEACAT sound speed 
profilers used to acquire conductivity, temperature, and depth (CTD) data in the water column 
to determine the speed of sound through water.  One of the SBE 19plus profilers has pressure 
sensors rated to 1000 meters.  The second SBE 19plus profiler has a pressure sensor rated to 
3,500 meters.  The two SBE 19plusV2 profilers have pressure sensors and units rated to 600 
meters. 
 
The SBE 19plus and SBE 19plusV2 SEACAT sound speed profilers were calibrated by the 
manufacturer during the 2011-2012 winter repair period.  The current calibration files can be 
found in Appendix I. 
 
Periodic quality assurance checks include comparison casts between CTD instruments.  Data 
quality assurance (DQA) checks are conducted during each survey leg include comparison 
casts between two instruments as per section 1.5.2.2.2 of the FPM for each survey.  Records of 
the DQA tests performed are kept aboard the ship and are included with the digital Separates II 
– Sound Speed Data for each survey.  To ensure that the CTDs continue to function properly a 
stringent maintenance schedule is followed using guidelines from the manufacturer's 
recommendations.     
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1.5.1.2 Moving Vessel Profiler 200 

A Brooke Ocean Technology, Ltd. (BOT) Moving Vessel Profiler 200 (MVP 200) is mounted 
in the aft starboard corner of the fantail (see Figure 14).  The MVP 200 system is a self 
contained sound speed profiling system capable of sampling water column profiles to 200 
meters deep from a vessel moving up to 12 knots.  The system is configured with a Single 
Sensor Free Fall Fish (SSFFF) outfitted with an Applied Microsystems Ltd. Sound Velocity 
and Pressure Smart Sensor.  Deeper profiles can be obtained by reducing the vessel speed.  
When the vessel is holding station, the system is capable of recording casts over 400m in 
depth. 
 
The MVP system consists of a winch, cable, fish (the towed unit with the sound velocity 
sensor), support assembly, and controlling hardware and software.  During data acquisition the 
fish is deployed using the on-deck controller and towed with enough cable out to keep the fish 
2-5 m below the water surface.  A “messenger” (a short cable-thickening sleeve) is set to allow 
the system to keep the appropriate amount of cable out and is reset as needed when the ship 
acquisition speed is altered. 
 
During SVP acquisition, the controlling computer application, BOT MVP with software 
version 2.401 (1/1/12-5/1/12) or 2.450 (5/15/12- current) is used to control the MVP system 
and to acquire SVP data.  The MVP allows for three acquisition modes: 1) automatic 
continuous multiple cast freefall casting while at speed, 2) single cast freefall casting while at 
speed, and 3) single cast winch speed casting while stationary.  The user limits the depth to 
which the fish will fall by setting 1) the depth-off-bottom 2) the maximum depth and 3) 
maximum cable out.  Either single, individually initiated casts can be performed at the 
discretion of the Hydrographer or the auto deployment function can be enabled and set with 
varying intervals (every 10 minutes, for example) for deployment. 
 
Fairweather has three Applied Microsystems Ltd. Sound Velocity and Pressure Smart Sensors.  
The current calibration files can be found in Appendix I. 
 
Periodic quality assurance checks include comparison casts between the MVP and one of the 
SBE 19plus or SBE 19plusV2 SEACATs.  Data quality assurance (DQA) checks include 
comparison casts among the instruments as per section 1.5.2.2.2 of the FPM for each survey.  
Records of the DQA tests performed are kept aboard the ship and are included with the digital 
Separates II – Sound Speed Data for each survey.   
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Figure 14: Fairweather’s MVP200 sound velocity system 

 
 
1.5.2 Surface Sound Speed   

1.5.2.1 Reson Sound Velocity Probe (SVP 70) 

Fairweather is equipped with one Reson SVP 70.  The SVP 70 measures the speed of sound 
near the ship’s hull mounted transducers to provide real time surface sound speed (SSP) values.  
The unit is mounted adjacent to the Reson 8160 as shown in Figure 15.   

 

 
Figure 15: Fairweather’s SVP 70 sound speed unit (left) and the 8160 
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The sound speed is output to the Reson 7111 and Reson 8160’s processing units.  The 
transducers require sound velocity information for beam forming.  The Reson 7111 and Reson 
8160 are not used to acquire data without real time sound speed information. 
 
The unit was installed during the 2009 winter drydock period in Seattle, Washington, at Lake 
Union Drydock Company.  The last calibration of the unit was dated January 4, 2009; and the 
calibration file can be found in Appendix I with the calibration file for the fleet spare, also 
listed on Fairweather’s hardware inventory. 
 
During project OPR-N326-FA-12 in Admiralty Inlet, the outer beams of the Reson 7111 were 
found to not meet IHO Order 1 specifications.  It was believed that the issue was related to how 
CARIS applied the SSP values to the round faced transducer data.  SSP files were deleted from 
all Reson 7111 CARIS HIPS HDCS processed data collected from May 1st, 2012 – June 29th, 
2012.  This action greatly improved the visual sound speed artifacts in the outer beams, but did 
not affect the outer beams still failing IHO Order 1 Uncertainty requirements.  
 
After verifying that CARIS HIPS was correctly applying SSP to the Reson 7111 data, no more 
SSP files were deleted after June 29th, 2012.  While in Bristol Bay working on the Fishpac 
Project (M-R908-FA-12), it was noticed that the SVP 70 values were no longer agreeing with 
the MVP sound speed values from the corresponding depth.  From July 15th – 21st, 2012, SSP 
values were entered directly into the Reson 7111 and 8160 from the MVP until Fairweather 
arrived in Dutch Harbor to arrange a hull dive for SVP 70 troubleshooting.  The SVP 70 was 
found to be fouled with marine life on July 21st, 2012 and after cleaning, the unit once again 
agreed with other sound speed instruments. 
 
1.5.2.2 Reson Sound Velocity Probe (SVP 71)   

Survey launches 2805 and 2808 are each equipped with a Reson SVP 71.  The SVP 71 
measures the speed of sound near the transducer to provide real time surface sound speed 
values to the Reson 7125’s processing unit.  The 7125 SV requires surface sound speed 
information for beam forming due to the flat faced transducer.  The units are hull-mounted 
adjacent to the Reson 7125’s transducers as shown in Figure 16.   
 
All of the sensors were initially calibrated by the manufacturer and current calibration files 
were supplied with the units upon receipt in 2010.  The delivery calibration files can be found 
in Appendix I. 
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Figure 16: SVP 71 sound speed unit (right) and a Reson 7125 

 
1.6 Vertical Control Equipment 

1.6.1 Water Level Gauges 
 

 Three (3) Sutron 9210B Portable Tide Gauges were provided to Fairweather by the Center for 
Operational Oceanographic Products and Services (CO-OPS) at the start of the 2012 field 
season.  The gauges are equipped with Paros Scientific Sensors for pressure measurements.  
The tide gauges are annually tested and inspected by CO-OPS Field Operations Division 
personnel to ensure that their accuracy and standards are being met.  CO-OPS provided 
documentation for the annual throughput testing conducted on each Portable Tide Gauge 
during February 2012. 
 
Installation and removal of the water level gauges is the responsibility of Fairweather 
personnel.  The CO-OPS-issued Portable Tide Gauges are furnished with necessary 
accessories; however, Fairweather maintains an inventory of tools and equipment necessary to 
support these gauges. 
 
1.6.2 Leveling Equipment 

Fairweather is equipped with four universal automatic levels (two Zeiss NI2 333 and two 
Leica NA2 100) and graduated metric staffs to assist in leveling tide gauges.  Calibration was 
conducted by Kuker-Ranken Inc. on February 26, 2011 on both Zeiss levels, as the Leica levels 
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are spares that have never been used they are calibrated bi-annually with their last calibration 
on February 2, 2010.  All calibration paperwork is maintained with reference documentation 
aboard Fairweather. 
 
A Kukkamaki procedure is performed prior to leveling in order to verify the collimation error.  
Procedures used followed those described in the User’s Guide for the Installation of Bench 
Marks and Leveling Requirements for Water Level Stations, October 1987.  Kukkamaki 
procedures were performed on March 2, 2012 for all four levels, and collimation errors were 
less than 0.05 mm/m. Detailed 2012 results are maintained with reference documentation 
aboard Fairweather. 
 
1.7 Horizontal Control Equipment 

Fairweather is equipped with two Trimble NetR9, one Trimble NetR5, and one Ashtech Z-
Xtreme dual-frequency GPS base stations used for the positioning of horizontal control marks, 
tidal benchmarks and aids to navigation.  These base stations can be configured for use as a 
portable DGPS or RTK reference station, or as a static receiver to record observations for use 
in post processing kinematic (PPK) correctors. 
 
Equipment accuracy testing of the three Trimble GPS units was performed by Fairweather 
personnel at MOC-P in Newport, OR during the week of March 19, 2012 through March 24, 
2012.  Data logging issues were encountered with the Ashtech Z-Xtreme GPS unit; therefore, it 
will not be utilized in acquisition for the 2012 field season.  The Online Positioning User 
Service (OPUS) solutions were obtained using data acquired with the Trimble GPS units over a 
local benchmark and comparing the solutions to each other and to the published data sheet for 
the geodetic mark used.  Data compared well within the accuracy of the published position of 
the benchmark.  The OPUS solutions are maintained with reference documentation aboard 
Fairweather.   
 
When deployed for PPK the base stations log data locally, either to internal or external 
memory, and the data is downloaded periodically.  The data is downloaded either by visiting 
the site or remotely via Freewave w900 MHz spread spectrum Ethernet radios mounted to 
Fairweather and her launches.  Station power needs are supported by batteries and solar 
panels.  All receiver antennas are mounted on a Seco, fixed height GPS tripod when deployed 
in the field.  Horizontal control equipment serial numbers and version installation dates are 
located in the hardware section of Appendix I. 
 

2.0 Software 

2.1 Software Systems Inventory 

An extensive software inventory with documentation of the software systems used by 
Fairweather is maintained as a survey Software Inventory spreadsheet on board Fairweather.  
This spreadsheet includes specifics such as software applications, versions, and hotfixes that 
are loaded on specific survey processing computers.  Snapshot .pdf files are produced monthly.  
The pertinent monthly inventories are included with the Supplemental Survey Records for the 
individual Descriptive Reports.   
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2.2 Data Acquisition Software  

2.2.1 Hypack® Hysweep 

Fairweather uses the Hypack® Hysweep acquisition software package to log all Reson MBES 
data.  Hysweep displays real-time MBES coverage geo-referenced against supporting 
background files such as charts and vector shoreline files for launch and ship helmsman to 
follow to acquire adequate MBES coverage.  The Hypack Devices (Hysweep Interface, 
Applanix POS MV Network, and MVP) and Hysweep Hardware (Hypack Navigation, 
Applanix POS MV Network, and Reson) *.ini files are created with the support of HSTP field 
support liaison and are in accordance with HSTP’s configuration management documentation.   
 
Three types of files are recorded per logged line of Reson MBES data: .raw, .hsx, and .7k.  The 
.raw file contains the raw navigation files recorded directly from the POS MV (as device 0) 
and from Hysweep (as device 1).  The .hsx files contain data from Hypack  Navigation (as 
device 0), POS MV (as device 1), and the Reson MBES (as device 2).  The .7k file contains all 
raw data that Hysweep can read from the Reson, including the Reson 7008 snippets message.   
 
The .hsx and .raw files are converted into HDCS data in CARIS HIPS by Fairweather 
personnel.  The .7k file is not post-processed by Fairweather personnel but is recorded for and 
submitted with the other raw data for outside backscatter research, processing and product 
development.  All three raw files are submitted directly to NGDC for archival.  Additionally, 
the MBES sensor offsets and mounting biases are entered into the respective vessel’s Hysweep 
Hardware device to facilitate later backscatter processing using Hypack GeoCoder.  Entry of 
device offset values in Hysweep Hardware causes the values to be logged in the header of the 
.hsx only, and does not affect the data pipeline.  These values are not tracked or closely 
monitored aboard Fairweather because they are not otherwise integral to meeting the 
requirements of the 2012 HSSD.      
 
2.2.2 CARIS Notebook 

CARIS Notebook™ can be used to directly collect detached shoreline positions and to verify 
shoreline.  The software is run on a field computer and receives the Trimble GPS data output 
from the GPS Pathfinder® Pro XRS receivers.   

GPS settings in CARIS Notebook are as follows:  
Maximum Horizontal Dilution of Precision (HDOP) = 3  
Maximum Positional Dilution of Precision (PDOP) = 6 
Minimum Signal-to-Noise Ratio (SNR) = 12 
Minimum Elevation Mask = 8° 
Minimum # of Satellites = 4 
 
Real-Time settings in CARIS Notebook are as follows:  
Source Type: Integrated Beacon – Manual Mode 
Position Mode: Corrected Only 
Age Limit: 20 seconds 
Differential GPS correction is applied in real-time using the unit’s integrated beacon as the 
primary corrector. The unit can be setup to run without using DGPS with position mode set to 
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“Autonomous Only” or with values different than those listed above.  These special 
circumstances of acquisition with altered parameters are recorded and documented in the 
individual Descriptive Report as appropriate.    
 
2.2.3 Klein SonarPro 

Klein SonarPro is a custom display and acquisition software package for use with Klein Side 
Scan sonar systems.  Fairweather uses SonarPro to monitor the quality of real-time imagery 
and to log raw side scan files in .SDF file format while acquiring Klein 5000 Side Scan data 
from the sled-mounted systems configurable on any of Fairweather’s launches.  Vessel 
navigation data from the POS MV is supplied to SonarPro and logged in the SDF file.  The raw 
SDF files are converted using CARIS SIPS into HDCS files for post processing and analysis.   
2.3  

2.3.1 Applanix POSView 

Applanix POSView is the controller software for the POS MV.  POSView is used to configure 
the serial and network input and output ports on the POS MV PCS.  POSView is also used to 
monitor real-time position and attitude data and their associated accuracies and to log POSPac 
.000 files.  The POSPac .000 file contains the TrueHeave information that is applied to the 
MBES HDCS data in CARIS HIPS immediately after conversion.  The POSPac .000 file is 
also post-processed into a PPK SBET file using Applanix’s POSPac processing software.  
  
 

2.4 Data Processing Software 

2.4.1 CARIS 

CARIS HIPS™ (Hydrographic Information Processing System) is used to process all 
multibeam data including data conversion, filtering, sound speed corrections, tide correction, 
merging and cleaning.  CARIS HIPS also calculates the Total Propagated Uncertainty (TPU) 
used to produce Bathymetry Associated with Statistical Error (BASE) surfaces which assist the 
Hydrographer in data cleaning and analysis, and to produce BASE surfaces.   
 
CARIS SIPS™ (Sonar Information Processing System) is used to process all side scan imagery 
data including data conversion, altitude adjustment, slant-range correction, and beam pattern 
correction.  CARIS SIPS is also used to inspect the imagery for contacts and to produce side-
scan imagery mosaics. 
 
CARIS Notebook™ and CARIS Bathy DataBASE™ BASE Editor (BDB) are used to compile, 
display, and edit source shoreline, shoreline updates and S-57 features that are collected 
directly in the field.  The .hob files created in Notebook and BDB are the current shoreline 
deliverables.    
 
CARIS Bathy DataBASE™ BASE Editor is also used for data quality assurance checks on the 
BASE surface and for surface differencing.  
 
CARIS Plot Composer is used to create final field plots and special constituent products.   
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2.4.2 Fledermaus™ 

Fledermaus ™, an Interactive Visualization Systems 3D™ (IVS 3D) program, is used for data 
visualizations and creation of data quality control products, public relations material and 
reference surface comparisons.   
 
2.4.3 Geocoder 

The use of any Geocoder software by Fairweather personnel to check Reson Snippet 
backscatter data and/or to create backscatter mosaics will follow best practices established by 
NOAA personnel to date.  If warranted, specifics of its use or findings for a given survey will 
be documented in the individual descriptive report.   
  
2.4.4 Applanix POSPac MMS and POSGNSS 

Applanix POSPac MMS and POSGNSS are used to post process POS MV data files logged 
simultaneously during MBES acquisition.  The Single Base PPK processing method is 
typically used when a single Fairweather or third party GPS base station is operating within 
approximately 20 kilometers of MBES acquisition.  The SmartBase™ PPK processing method 
is used when a stable network of approximately 5-10 available third party GPS base stations 
such as those in the Continuously Operating Reference Station (CORS) system or Plate 
Boundary Observatory (PBO) suite of stations exists within approximately 200 kilometers of 
MBES acquisition.  On occasion Precise Point Positioning (PPP) is used when sufficient base 
stations are not available for Single Base or SmartBase™ PPK.  In general, Fairweather 
processing procedures follow the methods outlined in the POSPac MMS GNSS-Intertial Tools 
User Guide for each method.  Processing methods specific to each project are documented in 
the Project Horizontal and Vertical Control Report.  Processing methods specific to each 
survey are documented in the Descriptive Report   
 
2.4.5 Velocipy 

Velocipy is a NOAA in-house software supported by the Hydrographic Systems and 
Technology Program (HSTP) that is used to process raw sound velocity cast files taken with 
the SEACAT CTDs on the launches and the MVP from the ship.  Velocipy creates CARIS 
format .SVP files that are applied during post processing in HIPS to MBES HDCS data to 
correct for sound speed.  The individual CTD and MVP files are concatenated into a single 
vessel file by survey.  Each vessel file contains the survey registry number and the time and 
location of each sound speed profile measured.   
 
2.4.6 Pydro 

Pydro, another NOAA program produced and maintained by HSTP, is used to produce Final 
Water Level Requests along with DTON Reports and Survey Feature Reports. The xml 
Descriptive Report (DR) is produced using the xmlDR component of Pydro, the DR pdf file is 
then produced via a stylesheet.  In addition, Pydro is used for Tidal Constituent and Residual 
Interpolation (TCARI) tide application in conjunction with CARIS HIPS and various other 
macros.   
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Pydro is utilized to assist with sidescan and multibeam contact correlation.  Information about 
each contact is easily entered, images can be added and a final feature report can be produced. 
 

3.0 Vessels  

3.1 Vessel Inventory 

Fairweather (S220) and her survey launches 2805 and 2808 are equipped to acquire multibeam 
echosounder (MBES) and sound speed profile (.svp) data.  The AMBAR (2302) and Metal 
Shark skiff (1810) are used primarily during shoreline verification, bottom sampling, and 
horizontal and vertical control operations.  All vessels may be used in support of dive, tide 
gauge, and horizontal control operations as well as for feature verification and bottom 
sampling.  See Appendix I for the complete vessel inventory. 
 

4.0 Data Acquisition 

4.1 Horizontal Control 

A complete description of horizontal control will be included in the project’s Horizontal and 
Vertical Control Report (HVCR), submitted for each project under separate cover when 
necessary as outlined in section 8.1.5.2 of the HSSD and section 5.2.3.2.3 of the FPM. 
 
The horizontal datum for all projects is the North American Datum of 1983 (NAD83) unless 
otherwise noted in the individual descriptive reports.   
 
Multibeam and shoreline data are differentially corrected in real time using correctors provided 
by Coast Guard beacons.  The specific beacons used for a given survey will be included in the 
Horizontal Control section of the survey’s descriptive report.  If loss of the differential beacon 
resulted in any data being recorded with C/A GPS positions it will be noted in the Descriptive 
Report for the specific survey.   
 
When possible, real time DGPS positioning may later be replaced with a post processed 
kinematic (PPK) single best estimate of trajectory (SBET). The PPK solution is usually 
dependent on a local base station supported by the ship and processed in Applanix POSPac 
MMS software using Single Base mode.  However, in areas with an adequate network of 
Continuously Operating Reference Stations (CORS) or public third-party base stations, 
Applanix POSPac SmartBase™ mode may be used.  The resulting navigation from PPK is an 
improvement over C/A and DGPS navigation. The details of PPK use and application for a 
given survey will be included in the Horizontal Control section of the project’s HVCR or the 
survey’s descriptive report.   
 
4.2 Multibeam Echosounder Acquisition and Monitoring Procedures 

Acquisition methods and platforms used are determined based on consideration of sonar 
system specifications, seafloor topography, water depth, and the capability of the acquisition 
platforms.   
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All multibeam data are acquired in Hypack’s Hysweep® SURVEY extension (.hsx) format and 
monitored in real-time using the 2-D and 3-D data display windows and the on-screen displays 
for the Reson 7125 SV, Reson 7111, and Reson 8160.  Adjustable parameters that are used to 
control the Reson include range scale, power, gain, pulse width, absorption, and spreading.  
These parameters are adjusted as necessary to acquire the highest quality of bathymetry and 
backscatter.  Vessel speed is predominantly between 6-8 knots for acquisition with launch 
7125 SV systems.  For Reson 7111 and Reson 8160 acquisition systems, vessel speeds are 6-
7.5 knots. Speeds are reduced as needed to eliminate noise from the data and to ensure the 
required along-track coverage for object detection in accordance with the HSSD.  Ship survey 
speed is increased to as fast as 10 knots for track line surveys without along track density 
requirements.  
 
Survey personnel follow standard operating procedures documented aboard Fairweather while 
setting and utilizing the Reson systems and Hypack for data acquisition.  The sensor offsets 
and mounting biases are entered into the Hysweep® Hardware Reson device.  This information 
is recorded in the Hypack hsx file header for corrected backscatter mosaics created with 
Hypack Geocoder.  These offsets do not have any effect on CARIS HIPS HDCS sounding 
corrections.    
 
Navigation and motion data are acquired and monitored in POSView and logged into a POS 
MV file with a .000 extension.  Various position and heading accuracies, as well as satellite 
constellations, are monitored real-time both in POSView and Hypack Hysweep®. 
 
Main scheme MBES acquisition lines using the Reson 7125 SV,  Reson 7111, and Reson 8160 
are generally run parallel to the contours and spaced no greater than three to four times the 
water depth and in most cases at a tighter line spacing to ensure the appropriate data density for 
the required finalized BASE surface resolutions.  For discrete item developments, line 
separation is reduced to two times the water depth to ensure least-depth determination by 
multibeam near-nadir beams.  Hypack Hysweep® real-time coverage display is used in lieu of 
pre-planned line files.  Hysweep® displays the acquired multibeam swath during acquisition 
and is monitored to ensure overlap and full bottom coverage.  If coverage is not adequate, 
additional lines are run while still in the area.  
 
For areas where shoreline verification is not conducted before multibeam, extra caution is 
taken by “half stepping” shoreward when operating near shore.  Half stepping is done by 
driving along the edge of real time coverage to prevent the survey vessel from ever being in 
un-surveyed waters.  Survey launch crews in the field survey to the Navigable Area Limit Line 
(NALL) line as defined by section 1.1.2 of the HSSD. 
 
4.3 Shoreline/Feature Verification 

The composite source file (CSF) in S-57/.000 format provided with the Project Instructions is 
the primary source for shoreline features to be verified.  The original project file is imported 
into CARIS Notebook, converted to a .hob file, clipped to the sheet limits for the specific 
survey, and named H#####_Original_Composite_Source.hob to be included with the 
deliverables.  This file is then copied and named H#####_Feature_File.hob to be utilized 
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during field verification.  Additionally, AWOIS items and other features to be investigated are 
provided to the field in the project reference file (PRF). 
Fairweather personnel conduct limited shoreline verification and reconnaissance at times near 
predicted negative tides within the survey limits when possible, as directed by section 3.5.5.3 
of the FPM.  Detached positions (DPs) are acquired and edits to the daily field feature files are 
recorded in CARIS Notebook and on paper DP forms and boat sheets.   
 
An inshore limit buffer line, offset 0.8 mm from the Mean High Water (MHW) line at the scale 
of the largest chart in the area, is provided with the Project Instructions.  This inshore limit 
buffer line is used in the shoreline acquisition software and on the boat sheet as a reference, 
and utilized as described in section 1.1.2 of the HSSD.  The NALL is determined in the field as 
the farthest off-shore of one of the following; the MHW inshore limit buffer specified above, 
the 4-meter depth contour, or the inshore limit of safe navigation as defined by the HSSD.  All 
shoreline features from the CSF seaward of the NALL are verified (including an update to 
depth and/or position as necessary) or disproved during operations.  Features off-shore of the 
NALL and not addressed or features of an ambiguous nature include remarks for further 
clarification.  Specifically assigned features may be investigated that are inshore of the NALL 
in accordance with the associated instruction for a given project area.  
 
Detached positions (DPs) acquired during shoreline verification indicate new features, 
revisions to source features, or source features not found in the field.  They are recorded in the 
shoreline acquisition software and on DP forms.  
 
4.4 Bottom Samples 

Bottom samples are acquired according to section 7.1 of the HSSD, any deviations from this 
protocol will be outlined in the individual Descriptive Report for the survey.  Samples are 
acquired using CARIS Notebook, Hypack target files (.tgt), or by logging the latitude, 
longitude, and bottom characteristics manually.  All samples are processed similarly to other 
shoreline features as outlined below in section C - 2.2 of this report.  Bottom sample results are 
included in the Notebook .hob deliverable layer, HXXXXX_Final_Feature_File and are 
descriptively attributed as New. 
 
4.5 Sound Speed 

Sound speed casts are taken at least once every 1–4 hours during multibeam survey operations 
in accordance with section 3.5.1 of the FPM.  Fairweather’s launches collect sound speed casts 
approximately every 3 hrs utilizing the SBE 19plus SEACAT sound speed profilers.  
Fairweather collects sound speed casts every 15- 30 minutes with the MVP dependant on the 
variability of sound speed conditions.  When the MVP is being serviced, casts with the SBE 
19plus units are also conducted by the ship at least every 4 hours.  Deviations from this 
procedure will be outlined in the individual Descriptive Report for the survey. 
 

C. QUALITY CONTROL 

Fairweather has numerous standard operating procedures (SOPs) that are followed by 
personnel throughout the survey to ensure consistent high quality data and products. 
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1.0 Uncertainty Modeling 

Uncertainty values for the multibeam and positioning systems on Fairweather and her survey 
launches were compiled from manufacturer specification sheets for each sensor (Heave, Pitch, 
Roll, Position, and Heading) and from values set forth in section 4.2.3.8 and Appendix 4 – 
CARIS HVF Uncertainty Values of the 2012 FPM. 
 
The manufacturer specification for POSMV heading accuracy is contingent on a 2 meter 
baseline between primary and secondary GPS antennas.  While the Fairweather has a 2 meter 
baseline her launches have on average a 1.4 meter baseline which has been seen to increase 
accuracy estimates in the field.  Based on observations in the field, the heading error value for 
all launches has been increased from the manufacturer specification and FPM guidance to 0.04 
degrees. 
 
Estimates for the Motion Reference Unit (MRU) alignment errors are taken from the standard 
deviation of the values determined by multiple personnel processing the patch test data (see 
section D 4.0).  In some instances, outlier patch test values are excluded to allow more 
reasonable MRU uncertainty values.                                                                          
 
The Fairweather TPU Values spreadsheet located in Appendix III, lists the final uncertainty 
values for Fairweather and her launches, including the default tides and sound velocity values.  
Uncertainty values relating to vessels and survey systems are entered into the HIPS Vessel File 
(HVF) for each platform.  The tidal errors for the gauge and for zoning are determined on a 
project by project basis. Sound speed uncertainties for a given survey are based upon either the 
defaults listed in the TPU value spreadsheet or based on utilization of NOAA sound speed 
uncertainty estimation software.  Survey specific uncertainty values for tides and sound speed 
that are entered during the Compute TPU step in CARIS HIPS and how they were determined 
will be included in the individual Descriptive Report.  After SBET application, TPU values are 
recalculated using the Error Data option for Uncertainty Source in the CARIS Compute TPU 
window.  This loads more precise residual mean square (RMS) values to selected HDCS lines 
for position, roll, pitch and gyro. 
 

2.0 Data Processing 

2.1 Multibeam Echosounder Data Processing 

Bathymetry processing followed section 4.2 of the FPM unless otherwise noted.   
 
Raw .hsx multibeam data are converted to CARIS HIPS HDCS format using established and 
internally documented settings.  After TrueHeave™, sound speed, and water level correctors 
are applied to all lines, the lines are merged.  Once lines are merged, Total Propagated 
Uncertainty (TPU) is computed.   
 
The general resolution, depth ranges, and Combined Uncertainty and Bathymetric Estimator 
(CUBE) parameter settings outlined in section 5.2.2.2 of the HSSD and section 4.2.1.1.1.1 of 
the FPM are used for surface creation and analysis.  If these depth range values for specific 
resolutions require adjustment for analysis and submission of individual surveys then a waiver 
from HSD Operations is required and would be requested.  A detailed listing of the resolutions 
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and the actual depth ranges used during the processing of each survey, along with the 
corresponding fieldsheet(s), will be provided in the Descriptive Report of each survey.   
 
BASE surfaces are created using the CUBE algorithm and parameters contained in the NOAA 
CUBEParams_NOAA.xml file as provided in Appendix 4 of the FPM The 
CUBEParams_NOAA.xml will be included with the HIPS Vessel Files with the individual 
survey data.  The NOAA parameter configurations for resolutions 1-32 meters are used.   
 
Multibeam data are reviewed and edited in HIPS subset mode and in swath editor as necessary.  
The finalized BASE surfaces and CUBE hypotheses are used for directed data editing at the 
appropriate depth range in subset editor.  The surfaces and subset editor view are also used to 
demonstrate coverage and to check for errors due to tides, sound speed, attitude and timing. 
 
Vessel heading, attitude, and navigation data are reviewed in HIPS navigation editor and 
attitude editor if deemed necessary upon review of surfaces.  Where necessary, fliers or gaps in 
heading, attitude, or navigation data are manually rejected or interpolated for small periods of 
time.  Any editing of this nature will outlined in the Descriptive Report for the particular 
survey. 
 
Due to the increased sounding densities seen during data collection, the Density method for 
hypothesis disambiguation is used.  This is a deviation from section 4.2.1.1.1 of the FPM 
which lists the default method as Density & Locale, this former method produced surfaces 
which were less likely to honor distinct features. 
 
The Surface Filtering functionality in HIPS may be used in the processing of survey data to 
reject errant soundings.  If utilized, the individual Descriptive Report shall list the confidence 
level settings for standard deviation used and discuss the particular way the surface filter was 
applied.  
 
In depths less than 20 meters and deeper and in areas of navigational significance where the 
BASE surface does not depict the desired depth for the given area, a designated sounding is 
selected.  Designated soundings are selected as outlined in section 5.2.1.2 of the HSSD. 
 
Layers determining “IHOness” are added to the CUBE surfaces allowing the Hydrographer to 
see where and if the surfaces meet IHO Order.  The process is easily performed in HIPS and 
allows the Hydrographer to identify areas of high uncertainty with respect to depth.  This is a 
spatial quality control check rather than just a statistical list of nodes and allows for specific 
areas with problems to be isolated and addressed.  The following logic equation is used to 
create “IHO_1” child layers in the 1 through 8 meter finalized surfaces:  
 
IHO-1:  -Uncertainty/((0.5^2 +((Depth*0.013)^2))^0.5), 
 
and an “IHO_2” child layer is created in the 8, 16 meter, and greater finalized surfaces using 
 
IHO-2:  -Uncertainty/((1.0^2 +((Depth*0.023)^2))^0.5). 
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It should be noted that both IHO order 1 (~80 to 100) and order 2 (100 to 176) child layers are 
created for the 8 meter surface since it overlaps the order 1 and order 2 boundary (order1<100 
meters, order 2>100 meters).  IHO surfaces are utilized during data collection and processing 
as an additional child layer of the finalized surfaces to indicate problem areas that need 
attention or discussion.  Additionally, the percentage of IHO nodes passing from the combined 
finalized surfaces is included in the Descriptive Report for each survey.  Statistics on node 
percentage are computed using a python script created by Weston Renoud which is retained on 
Fairweather.  For visual depiction of localized areas that do not meet IHO standards, screen 
grab(s) of the individual finalized IHO child layer(s) may also be included. 
 
The individual finalized or combined surface’s IHO layers are exported from CARIS as a text 
file and examined to allow the Hydrographer to see the full data distribution rather than just the 
minimum and maximum values in the surface.  These data distribution are used to assess the 
quality of the survey, to ensure ninety-five percent of the data meets the appropriate IHO order 
as specified in section 5.1.3 of the HSSD.   
 
Additionally, a combined surface is reviewed in 3-D mode using one of the following 
programs, CARIS HIPS, CARIS Base Editor, or IVS Fledermaus, to ensure that the data are 
sufficiently cleaned for submission. 
 
2.2 Side Scan Sonar Data Processing 

Side scan processing followed section 4.3 of the FPM unless otherwise noted.   
 
Raw .sdf side scan data are converted to CARIS SIPS HDCS format using established and 
internally documented settings.  The towfish navigation is recomputed and slant range 
corrections are completed.   For hull mounted configurations the towfish navigation is 
recomputed using a zero value for cable out.  For a towed configuration, both cable out and 
towfish depth are recorded in the raw data and used to recompute the towfish navigation. 
 
The side scan sonar system must be able to detect an object on the sea floor that measures 1m x 
1m x 1m and is ensonified a minimum of three times per pass.  The effective range for the side 
scan is to operate the towfish height 8-20 percent of the range scale.   
 
Daily checks are required to ensure the minimum size objects are being detected.  This is 
accomplished as passing by a buoy moorings, wreck or known object.  The object must be 
detected on both the port and starboard channels.   
 
The data is reviewed and objects are selected based on depth of water and height of shadow.  If 
the depth is less than 20 meters then any object with a shadow of 1 meter is considered 
significant.  Significant contacts in depths greater than 20 meters are defined as an object that 
rises off the seafloor at 10 percent of the water depth.  All selected contacts are imported to 
Pydro and correlated based on location and notes are added as to whether the object is 
significant.  Significant contacts are investigated further with multibeam echosounder. 
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A mosaic of the side scan data is created using CARIS Mosaic Editor to assess coverage and 
one mosaic should be created for each 100 percent completed.  Side scan mosaics should be 1 
meter by 1 meter pixel resolution. 
 
2.3 Shoreline/Feature Data Processing 

During shoreline verification, field detached positions (DP) are acquired with CARIS 
Notebook or Hypack .tgt files.  Tide application for features requiring tide correction is applied 
in CARIS Notebook when using discrete zoning and with the aid of Pydro when TCARI is 
used.   
 
New features and any updates to the composite source shoreline, such as ledges or reefs, are 
acquired or digitized with S-57 attribution and are compiled from the field daily files into the 
H#####_Final_Feature_File.hob.  Updates to source shoreline features primarily include a 
change in depth/height, position, or S-57 classification.  Notebook’s editing tools are used to 
modify source feature extents or positions.   
 
The SORIND and SORDAT S-57 attribute fields for new features or modified source features 
are updated to reflect the information for the associated survey number and date 
(US,US,graph,H#####).  All new or modified features are S-57 attributed as applicable and 
descriptively attributed as New or Update respectively.  All unmodified source features retain 
their original SORIND and SORDAT values.  Assigned features that are addressed but not 
updated are descriptively attributed as Retain and unaddressed assigned features are attributed 
as Not Addressed. 
 
Short descriptive comments taken from the boat sheets or DP forms along with investigation or 
survey methods are listed under the Remarks field.  For significant features that deserve 
additional discussion, the Hydrographer may include a recommendation to the cartographer in 
the Recommendations field, along with the Hydrographer notes and investigation methods 
provided in the Remarks field.  
 
Features that are disproved or that do not adequately portray the shoreline are descriptively 
attributed as Delete in the H#####_Final_Feature_File.hob layer.  Features with the attribution 
of Delete retain their original SORIND and SORDAT values and include a recommendation 
from the Hydrographer along with an informative remark.  
 
AWOIS investigation items are received in the Project Reference File and investigated as 
necessary.  Features correlated to the AWOIS item are included in the 
H#####_Final_Feature_File.hob layer and labeled with the appropriate AWOIS number and 
include a remark detailing the search methods and a recommendation from the Hydrographer.  
Items will be attributed as AWOIS for reporting purposes.  Any features that are submitted as 
dangers to navigation (DTON) will be attributed accordingly for reporting purposes.  The 
status of Primary or Secondary may be attributed to aid in deconflicting multiple positions or 
instances of the same feature.  
 
Images are labeled and associated with a DP/userid number or other descriptive/unique name.  
They are included with the survey data and stored in the CARIS/Multimedia folder with the 
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deliverables.  References to the images are listed with file extension and comma delimited in 
the Images attribute for the specific feature. 
 
The CARIS Notebook files along with CARIS HIPS BASE surface(s) are viewed to compare 
MBES coverage and features simultaneously.  The current NOAA object catalog will be used 
for CARIS Notebook processing and the version of such will be documented in the individual 
Descriptive Reports, along with any deviations in shoreline processing from those listed above. 
 
Final shoreline deliverables are two S-57 (*.000) files exported from Notebook, the H##### 
Original Composite Source and the H##### Final Feature File, included with the processed 
data.   
 

3.0 Data Review 

Specific procedures are used on Fairweather to ensure quality control of data throughout 
acquisition, processing, and submission.  These procedures are documented and followed by 
the Hydrographer.  A detailed Quality Control check is performed by the survey manager.  A 
detailed review is conducted by qualified survey personnel (FOO, CST, SST, or PS) other than 
the survey manager as an outside review of the survey data and deliverables.  Submission 
checklists are used to ensure that all data and deliverables are complete and included upon 
submission.  Documentation of these tasks is completed for every survey but only the final 
processing log, H##### Data Log, is included in the Separates submitted with the individual 
survey data. 
 

D. Corrections to Echo Soundings 

1.0 Vessel HVFs 

CARIS HIPS Vessel Files (HVF) are created by Fairweather personnel and used to define a 
vessel’s offsets and equipment uncertainty.  The HVF is used for converting and processing 
raw Hypack .hsx and .raw files to CARIS HIPS HDCS format.   The HVFs used for a given 
project are included with the digital data submitted with the survey.   
 

2.0 Vessel Offsets  

Sensor offsets are measured with respect to each vessel’s reference point.  The reference point 
for Fairweather and her survey launches 2805 and 2808 is the top, center of the POS MV IMU 
(Figure 17).  The offset values from the reference point to the primary GNSS antenna are 
entered into Applanix’s POSView POS MV monitoring software so that all raw position data 
are centered at the vessel’s reference point.  The CARIS HVF contains the offset from the 
vessel’s reference point to the multibeam sonar reference point. 
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Figure 17: Vessel Reference Point (Top of POS MV IMU) & Primary GNSS Antenna (port side). 
 
 
Additionally, the Reson sonar mounting offsets measured from the center of each projector to 
the center of the transceiver are entered in the Reson 7125 hardware configuration with the 7K 
Center for both the 400 kHz and 200 kHz projectors.  The measured values are used instead of 
Reson’s default values because Fairweather’s mounts are slightly different than of Reson’s 
standard sonar mount (Figure 18).   
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Figure 18: Reson 7125 sonar mounting with 400kHz and 200kHz offsets respectively. 

 
 
A ship survey of Fairweather was completed by Westlake Consultants, Inc on September 23, 
2003.  A spatial relationship survey of Fairweather POS MV components was conducted by 
NOAA’s National Geodetic Survey (NGS) in February 2007, and again on February 15, 2009, 
while the ship was in Lake Union Drydock in Seattle, WA.  The results of the Westlake, the 
2009 NGS survey, and additional offset values discussed below in section D 4.0 are used to 
determine the offsets for the ship.  The reports from each survey, whose values are used for the 
offset measurements, are located in Appendix II.  The S220 Offsets & Measurements 
spreadsheet is also included in Appendix II, listing the final values for Fairweather’s offsets 
with explanations of how they were calculated.  
 
Permanent control points were established on launches 2805 and 2808 during construction at 
All American Marine in 2009.  Sensor offsets were measured by NGS in January 2010 using 
the methods described in the report on each launch located in Appendix II of this report.  The 
resultant offsets, measurements, derivations, descriptions of methodology used, diagrams, and 
coordinate system references are included in the respective vessel’s Offsets & Measurements 
spreadsheet also included in Appendix II.   
 

3.0 Static and Dynamic Draft 

The static drafts (Waterline Height in the HVF) for launches 2805 and 2808 were calculated 
based on steel tape and plumb bob measurements of the distance from benchmarks on the port 
and starboard quarter of the vessel to the waterline.  The values and calculations for static draft 
of the various launches are listed in the respective Waterline Measurement spreadsheets 
included in Appendix II of this report. 
 
The static draft of Fairweather was measured under different loading conditions with different 
amounts of fuel.  The bow and stern draft marks were recorded and then used to perform a 
linear interpolation of the static draft at Fairweather’s IMU.  The Ship Draft 2012 spreadsheet 



 

 - D-28 -  

2012 DAPR NOAA Ship Fairweather 

records the static draft values and is included with the ship offset documentation in Appendix 
II. 
 
Fairweather’s dynamic draft measurement was taken May 10, 2012 in Puget Sound.  The 
dynamic draft data were acquired for launches 2805 and 2808 in Newport, OR in the Yaquina 
River.  Data was acquired at slack current and values agreed well with the previous year.  The 
measurements were made using the change in ellipsoid height while the vessels were transiting 
at different speeds in their respective locations.  The ellipsoid heights were determined using 
Post Processed Kinematics (PPK) by recording POSPac data on each vessel and then 
processing the data with local reference stations in Applanix POSPac MMS software. The 
resulting Single Best Estimate of Trajectory (SBET) was exported from POSPac and the speed 
versus ellipsoid height was fit to a third order polynomial curve using a least squares fit 
method in a Python Script written by NOAA personnel and implemented within Pydro.  When 
available MLLW verified levels were loaded into Pydro for dynamic draft locations influenced 
with tides.  The polynomial curve was used to derive the table used in the CARIS HVF, and 
the standard deviation of the residuals was used to determine the associated uncertainty in the 
measurement.  Written reports for each platform including initial measurement notes, graphs, 
and finalized values are provided in Appendix II of this report.  The polynomial best fit curve 
of the ellipsoidal height differences from launches 2805 and 2808 compare well with each 
other and previous years.  The dynamic draft offset values and standard deviations were then 
entered into the CARIS HVFs. 
 

4.0 Patch Tests 

Patch tests were conducted in accordance with section 5.2.4.1 of the HSSD on launches 2805 
and 2808 for the Reson 7125 SV MBES sonar systems during the months of March and April 
2012 using the Shilshole Bay Reference Surface and Patch Test site near Seattle, WA.  Patch 
tests were also conducted for Fairweather’s -Reson 8160 and Reson 7111 MBES sonar 
systems using the Shilshole Bay Reference Surface and Patch Test site.  The patch test results 
for the 8160 system were deemed unreliable and the 2011 patch test values were used as no 
changes were made to the configuration of that sonar.  The results of all patch tests to date, 
along with the acquisition and processing logs, are included in the individual MBES 
Calibration files in Appendix II.   
 
Also included in Appendix II is the sounding system comparison.  This comparison includes 
surface differencing between all launch and ship MBES reference surfaces using CARIS Bathy 
Database.  The results of both comparisons show that the differences between each platform 
and sonar are within NOAA specification for vertical uncertainty. 

5.0 Attitude and Kinematic Data 

Vessel attitude is measured by the POS MV and recorded in the Hysweep .hsx file.  Roll is 
applied real time to Reson 8160 and Reson 7125 SV data.  Pitch is applied real time to Reson 
7111 and Reson 8160 data.  Attitude measurements not applied in real time (heave, pitch, roll, 
and heading) are applied during post processing in CARIS HIPS using the raw POS MV 
attitude data recorded in the Hysweep .hsx file.  Post processed kinematic (PPK) data from the 
POS MV .000 file are applied to MBES data in CARIS HIPS in the form of SBET files once 
all data acquisition is complete.    
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5.1 TrueHeave™ 

The POS MV TrueHeave™  data is logged within the POS MV .000 files and applied in 
CARIS HIPS during post processing using the “Apply TrueHeave” function.  TrueHeave™ is a 
forward-backward filtered heave corrector as opposed to the real time heave corrector, and is 
fully described in Section 6 of the POS MV V4 User Guide 2009.  To ensure proper application 
in CARIS HIPS, POS MV files are logged for at least three to five minutes before and after all 
MBES files are logged.  
 
If the POS MV files fail to apply in CARIS HIPS during the “Apply TrueHeave” process the 
files are fixed using a CARIS tool called “fixTrueHeave.exe.”  In cases where this is necessary 
a new fixed file is created with the extension “.fixed” (2011-ddd-vssl.000.fixed). The new 
fixed TrueHeave™ file is then applied to the data in CARIS HIPS.  The original corrupted file 
is retained along with the fixed file with the submitted Global Navigation Satellite System 
(GNSS) data.  Occurrences of this for specific surveys are noted in the individual Descriptive 
Reports. 
 
In cases where TrueHeave™ cannot be applied, real time heave correctors are used.  Real time 
heave data are recorded and stored in the Hypack Hysweep .hsx file and are applied as the 
heave corrector for MBES data if TrueHeave™ files are unavailable.  Data that do not have 
TrueHeave™ applied will be listed in the individual Descriptive Report for the survey.  
 
5.2 Post Processed Kinematic Data 

 
Post Processed Kinematic (PPK) data in the form of Single Best Estimate of Trajectory 
(SBET) files are applied to soundings to increase the accuracy of the kinematic vessel 
corrections and to allow the ability to reference soundings to the ellipsoid.   
 
Standard daily data processing procedures aboard Fairweather include post processing of POS 
MV kinematic .000 files using Applanix POSPac MMS and POSGNSS software using either 
Single Base or SmartBase batch processing methods as described in section B.2.3.4.   After 
processing and quality control analysis of the post-processed SBET files is complete, the SBET 
and SMRMSG files are applied to the HDCS data in CARIS HIPS using the “Load 
Attitude/Navigation Data”, the “Load error data…”, and “Compute GPS Tide” processing 
tools.  Ellipsoidal heights are contained within the PPK SBET files.  Soundings to which 
SBETs have been applied can be reduced to the ellipsoid by merging the data in CARIS HIPS 
with “GPS Tide” applied.  Data are frequently referenced to the ellipsoid during data analysis 
for troubleshooting unexplained vertical offsets.  
 
Positioning of features and bottom samples is not corrected with post processed GNSS data 
because at this time as there is not a developed nor streamlined procedure for PPK application 
to features. 
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6.0 Sound Speed 

Seabird SBE 19plus and SBE 19plusV2 sound speed profilers are used regularly to collect 
sound speed data for the Reson 7125 SV MBES systems on survey launches 2805 and 2808, 
and used on an as needed basis for Fairweather’s Reson 7111 and Reson 8160 MBES systems.  
The Brooke Ocean Technology Moving Vessel Profiler (MVP) is primarily used to collect 
sound speed data for sound speed correction of data acquired with Fairweather’s Reson 7111 
and Reson 8160 MBES systems unless otherwise noted in the individual descriptive reports. 
 
Daily sound speed profiles from the SBE 19plus and SBE 19plusV2 profilers are processed 
with Velocipy and concatenated into single .svp files for each vessel per survey.  Individual 
.svp files and the concatenated vessel files for the survey are submitted with each survey.    
 
Sound speed profiles acquired using the Brooke Ocean Technology Moving Vessel Profiler 
200 (MVP) are stored in files labeled BOT_XXXX.calc, where X is the incrementally 
increasing cast number.  The .calc file for each cast is opened with Velocipy and converted into 
CARIS .svp file format.  The individual .svp profiles are concatenated into vessel specific .svp 
files for the entire survey.  Individual sound speed profiles taken by the MVP are not submitted 
separately due to the large number of casts acquired and the way in which they are processed; 
however, the daily concatenated files are submitted for backup purposes and include all 
profiles acquired.   
 
The concatenated sound speed files are applied to multibeam data in CARIS HIPS during data 
processing.  CARIS HIPS uses one of four different methods to automatically apply a sound 
speed profile stored in a concatenated sound speed file.  They are: “previous in time,” “nearest 
in time,” “nearest in distance” and “nearest in distance within time.”  The method of applying 
sound speed for a specific day of data collection is listed in the daily logs included as Separates 
submitted with the individual survey data. 
 

7.0 Water Level 

Unless otherwise noted in the survey Descriptive Report, the vertical datum for all soundings 
and heights is Mean Lower Low Water (MLLW).  Predicted, preliminary, and/or verified water 
level correctors from the primary tide station(s) listed in the Project Instructions may be 
downloaded from the CO-OPS website and used for water level corrections during the course 
of the project.  These tide station files are collated to include the appropriate days of 
acquisition and then converted to CARIS .tid file format using FetchTides.   
 
Water level data in the .tid files are applied to HDCS data in CARIS HIPS using the zone 
definition file (.zdf) or a Tidal Constituent and Residual Interpolation (TCARI) model supplied 
by CO-OPS.   Upon receiving final approved water level data, all data are reduced to MLLW 
using the final approved water levels as noted in the individual survey’s Descriptive Report. 
 
A complete description of vertical control utilized for a given project can be found in the 
project specific Horizontal and Vertical Control Report (HVCR), submitted for each project 
under separate cover when necessary as outlined in section 5.2.3.2.3 of the FPM. 
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Field Unit: FAIRWEATHER

Effective Date: April 10, 2012

Updated Through: November 29, 2012

Vessel Name FAIRWEATHER Launch 2805 Launch 2808 Ambar 700 Skiff FRB

Hull Number S 220 2805 2808 2302 1810 2301

Call Letters WTEB

Manufacturer Aerojet-General Shipyards All American Marine All American Marine Marine Silverships, Inc Metal Shark Zodiak of North America

Year of Construction 1967 2009 2009 1998 2012 2004

Type of Construction
Welded steel hull -
 ice strengthened

Welded Aluminum Welded Aluminum RHIB (Aluminum) Welded Aluminum RHIB (Fiberglass)

Length Overall 70.4 m (231') 8.64 m (28' 6") 8.64 m (28' 6") 7.0 m (23') 4.57 m (15') 6.7 m (22')

Beam 12.8 m (42') 3.48 m (11' 5") 3.48 m (11' 5") 2.9 m (9' 4") 4.44(8') 2.6 m (8' 6")

Draft 4.7 m (15' 6") 1.12 m (3' 8") 1.12 m (3' 8") 0.4 m (1' 4") (18") 0.6 m (22")

Cruising Speed 12.5 knots 24 knots 20 knots 22 knots 16 knots 18 knots

Max Survey Speed 8 knots 8 knots 8 knots

Date of Effective Full Vessel 
Static Offset Survey

Origninal Survey 9/23/2003      
POS/MV Offsets Surveyed 2/2007 

and 2/15/2009
1/26/2010 1/27/2010

Organization which Conducted 
the Effective Full Offset Survey

Original Survey -  Westlake 
Consultants                   

POS/MV Spatial Surveys - NGS
NGS/GSD NGS/GSD

Date of Last Partial Survey or 
Offset Verification & Methods 
Used

n/a n/a n/a

Date of Last Static Draft 
Determination & Method Used

6/3/2011                     
Draft Marks                   

3/25/2011
Direct Measurement from 

benchmarks.

3/14/2011
Direct Measurement from 

benchmarks.
  

Date of Last Settlement and 
Squat/Dynamic Draft 
Measurements & Method Used

6/3/2011                     
Post Processed Kinematic 
(Ellipsoidally referenced)

3/25/2011
Post Processed Kinematic 
(Ellipsoidally referenced)

3/02/2011
Post Processed Kinematic 
(Ellipsoidally referenced)

Orange - info needs to be verified

GREY - not applicable

Hydrographic Vessel Inventory

SURVEY VESSELS



2012 FA Hardware Inventory
Item Name Serial # Manufacturer Type/Model CD Tag # Firmware Location Comments/Notes Status

1JKCZF1 DELL Precision T3400 CD0001615471 Newport, OR Warehouse
Excess paperwork needs to be completed and 
hardrive drilled

Transferred

2NP1PD1 DELL Precision 490 CD0001615380 Newport, OR Warehouse
Excess paperwork needs to be completed and 
hardrive drilled

Transferred

3JKCZF1 DELL Precision T3400 CD0001615472 F‐06‐002 (Server Room) Re‐purposed by CET for non‐survey use Transferred

3M1PD1 DELL Precision 490 CD0001615381 Newport, OR Warehouse
Excess paperwork needs to be completed and 
hardrive drilled

Transferred

9MP1PD1 DELL Precision 490 CD0001615385 Newport, OR Warehouse
Excess paperwork needs to be completed and 
hardrive drilled

Transferred

JHKCZF1 DELL Precision T3400 CD0001615468 Newport, OR Warehouse
Excess paperwork needs to be completed and 
hardrive drilled

Transferred

MP1PD1 DELL Precision 490 CD0001615384 Newport, OR Warehouse
Excess paperwork needs to be completed and 
hardrive drilled

Transferred

10m Lead Line 10_01_05 FA Personnel Traditional NOAA Ship Fairweather S220 vfd for HSRR 2012 Lost
10m Lead Line 10_02_05 FA Personnel Traditional NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
10m Lead Line 10_05_09 FA Personnel V‐100/Non‐Traditiona NOAA Ship Fairweather S220 vfd for HSRR 2011 OK
10m Lead Line 10_06_XX FA Personnel V‐100/Non‐Traditiona NOAA Ship Fairweather S220 Not in service, still being completed. OK
20m Lead Line 20_01_05 FA Personnel Traditional NOAA Ship Fairweather S220 vfd for HSRR 2012 Lost
20m Lead Line 20_02_05 FA Personnel Traditional NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
20m Lead Line 20_03_05 FA Personnel Traditional NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
2805‐Acq 40001000160708 CYBERTRON P4 VD0001703149 FA Launch 2805 Acq 2805‐ vfd for HSRR 2012 OK
2806‐ Acq 40001000160709 CYBERTRON P4 CD0001703148 F‐06‐002 (Server Room) Space Acq Machine (2806) OK
2807‐ Acq 40001000160711 CYBERTRON P4 CD0001703146 Plot 3 Spare Launch Acq Machine(2807) OK
2808‐Acq 40001000160707 CYBERTRON P4 CD0001703147 FA Launch 2808 Acq 2808‐ vfd for HSRR 2012 OK
30m Lead Line 30_01_05 FA Personnel Traditional NOAA Ship Fairweather S220 vfd for HSRR 2012 OK

7111 Rx (EM7187) 1409093 Reson 7111 ‐ Transducer NOAA Ship Fairweather S220
Used Rx purchased from Reson and installed in 2012 
drydock

OK

7111‐ TPU 2009003 Reson 7111 ‐ TPU  CD0001065312 NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
7111 Tranceiver Boards 3309001 Reson 7111 ‐ Tranceiver NOAA Ship Fairweather S220 In conference room‐ vfd HSRR 2012 Needs Service

7111 Tx (TC2126‐3) 4608498 Reson 7111 ‐ Transducer NOAA Ship Fairweather S220
Used Tx purchased from Reson and installed in 2012 
drydock

OK

7111 Wet End 5008001 Reson 7111 ‐ Transducer NOAA Ship Fairweather S220 Prepared to send back to Reson Needs Service

7125‐ 200kHz TX 1008117 Reson
7125 ‐ 200 Projector 
(2163)

CCOM/JHC (New Hampshire) Returned to UNH for additional testing On Loan

7125‐ 200kHz TX 2409098 Reson
7125 ‐ 200 Projector 
(2163)

FA Launch 2808 vfd for HSRR 2012 OK

7125‐ 200kHz TX 4408351 Reson
7125 ‐ 200 Projector 
(2163)

Manufacturer Sent to Reson for evaluation/repair Manf. Repair

7125‐ 200kHz TX 4408358 Reson
7125 ‐ 200 Projector 
(2163)

C‐02‐001 Swapped for Calibrated UNH sonar and put in storage OK

7125‐ 400kHz TX 1908209 Reson
7125 ‐ 400 Projector 
(2160)

CCOM/JHC (New Hampshire) Returned to UNH for additional testing On Loan

7125‐ 400kHz TX 2208007 Reson
7125 ‐ 400 Projector 
(2160)

FA Launch 2808 vfd for HSRR 2012 OK

7125‐ 400kHz TX 2308110 Reson
7125 ‐ 400 Projector 
(2160)

Manufacturer Sent to Reson for evaluation/repair Manf. Repair

7125‐ 400kHz TX 4008071 Reson
7125 ‐ 400 Projector 
(2160)

C‐02‐001 Swapped for Calibrated UNH sonar and put in storage OK

7125‐ RX 0309014 Reson 7125 ‐ Rx (EM7200) CCOM/JHC (New Hampshire) Returned to UNH for additional testing On Loan

7125‐ Rx 3008265 Reson 7125 ‐ Rx (EM7200) C‐02‐001 Swapped for Calibrated UNH sonar and put in storage OK

7125‐ RX 309012 Reson 7125 ‐ Rx (EM7200) FA Launch 2808 vfd for HSRR 2012 OK
7125‐ RX 309019 Reson 7125 ‐ Rx (EM7200) Manufacturer Sent to Reson for evaluation/repair Manf. Repair

7125‐ TPU 1812020 Reson 7125 ‐ TPU CD0001527818
7k UI: 3.12.5.8, 7k Center: 
3.7.7.9, 7kIO: 3.4.1.11

CCOM/JHC (New Hampshire) Returned to UNH for additional testing On Loan

7125‐ TPU 1812023 Reson 7125 ‐ TPU CD0001529704
7k UI: 3.12.5.8, 7k Center: 
3.7.7.9, 7kIO: 3.4.1.11

FA Launch 2808 vfd for HSRR 2012 OK

7125‐ TPU 1812027 Reson 7125 ‐ TPU CD0001529685
7k UI: 3.12.5.8, 7k Center: 
3.7.7.9, 7kIO: 3.4.1.11

Manufacturer Sent to Reson for evaluation/repair Manf. Repair

7125‐ TPU 1812028 Reson 7125 ‐ TPU CD0001529714
7k UI: 3.12.5.8, 7k Center: 
3.7.7.9, 7kIO: 3.4.1.11

C‐02‐001 Swapped for calibrated sonar from UNH OK

8125‐ TPU 31562 Reson 8125 ‐ TPU CD0000825308
Dry: 8125‐2.10‐A50F, Wet: 
8125‐1.08‐9E98

NOAA Ship Rainier S221 Txfred to RA for 2012 field season On Loan

8125 Transducers 4400007 Reson 8125 ‐ 455 Projector NOAA Ship Rainier S221 Txfred to RA for 2012 field season On Loan



8160‐ TPU 35385 Reson 8160 ‐ TPU CD0001065313
Dry: 8160‐2.09‐7C6D, Wet: 
8160‐1.00‐E9E1

NOAA Ship Fairweather S220 vfd for HSRR 2012 OK

8160 Tranceiver Boards 35028 Reson 8160 ‐ Tranceiver NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
8160 Wet End FA‐8160 Reson 8160 ‐ Transducer NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
8‐Port Gigabit Switch RMQ00J700115 Lynksys SRW2008 (P004421) 2806 OK
8‐Port Gigabit Switch RMQ00J700119 Lynksys SRW2008 (P004424) 2808 OK
8‐Port Gigabit Switch RMQ00J700285 Lynksys SRW2008 (P004422) 2805 OK
8‐Port Gigabit Switch RMQOOJ70016 Lynksys SRW2008 SPARE (C‐02 STORES) OK
ACQ‐1 CSH8FN1 DELL Precision T3400 CD0001615444 Plot 1 Acq1‐ vfd for HSRR 2012 OK

Acq‐2 HG7CWK1 DELL Precision T3400 CD0001766763 Plot 1
Perminately re‐purposed as Acq2 and relocated to acq 
station.

OK

Antenna cable XXX4 Trimble OK
Bay Hydro 5410 260 Klein 5410 ‐ Towfish NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
Camcorder Batteries XXX5 Trimble OK
CST DJKBZK1 DELL Precision T3400 CD0001766913 Plot 1 Now used as CST computer OK
data/power cable 1 XXX7 Trimble OK
DGPS Antenna 0328‐12352‐0002 CSI Wireless MGL3 Matrix OK
DGPS Antenna 0919‐9231‐0191 Hemisphere MA40 C‐02‐001 SPARE (C‐02 STORES) OK
DGPS Antenna 0919‐9231‐0193 Hemisphere MA40 C‐02‐001 SPARE (C‐02 STORES) (2806) OK
DGPS Antenna 0924‐9488‐0040 Hemisphere MA40 FA Launch 2808 OK
DGPS Antenna 0924‐9488‐0046 Hemisphere MA40 FA Launch 2805 OK
DGPS Antenna 220395038 Trimble 33580‐00 ? C02 OK
DGPS Antenna 9824‐1779‐0002 CSI Wireless MGL3 NOAA Ship Fairweather S220 OK
DGPS Receiver 0324‐11969‐0002 CSI Wireless MBX‐3S CD0001065375 P012‐0.1‐Bx NOAA Ship Fairweather S220 OK
DGPS Receiver 0328‐12362‐0001 CSI Wireless MBX‐3S 10652291 D‐02‐001 (ET Stores) OK
DGPS Receiver 0923‐9416‐0005 Hemisphere MBX‐4 CD0001709329 P012‐0.010‐Bx C‐02‐001 SPARE (C‐02 STORES) (2806) OK
DGPS Receiver 0923‐9416‐0007 Hemisphere MBX‐4 P012‐0.010‐Bx C‐02‐001 SPARE (C‐02 STORES) OK
DGPS Receiver 0924‐9498‐000 Hemisphere MBX‐4 P012‐0.010‐Bx FA Launch 2808 OK
DGPS Receiver 0927‐9567‐0001 Hemisphere MBX‐4 CD0001709331 P012‐0.010‐Bx FA Launch 2805 OK
Digibar Pro 98207 Odom Hydrographic Systems DB 1200 A009511 SW 1.11 OK
Divers Least Depth Gauge 68337 PTC MODIII CD0001698256 F‐05‐002 (ET Shop) Having issues Needs Service
Divers Least Depth Gauge DT15894 RJE International Inc. TAC‐DDGC‐III P004373 Plot 3 New unit, but part needed OK
Divers Least Depth Gauge DT16313 RJE International Inc. TAC‐DDGC‐III P004372 Plot 3 In service OK
dual battery cable 2 XXX8 Trimble OK
FOO 7G7CWK1 DELL Precision T3400 CD0001766754 Plot 1 Now used as FOO computer OK
GPS Antenna 12297641 Trimble Zephyr Geodetic C02 OK
GPS Antenna 13843.531 NovAtel 531 ET Stores D2 OK
GPS Antenna 1441027807 Trimble Zephyr Geodetic 2 field or O‐lab OK
GPS Antenna 1441031361 Trimble Zephyr Geodetic 2 field or O‐lab OK
GPS Antenna 18250.531 NovAtel 531 ET Stores D2 OK
GPS Antenna 18284.531 NovAtel 531 ET Stores D2 OK

GPS Antenna 220298707 Trimble
Trimble Micro Centered 
L1/L2

(NOAA Launch 
Barcode A20

C02 OK

GPS Antenna 30325441 Trimble Zephyr Geodetic 2 C02 OK
GPS Antenna 30767996 Trimble Zephyr Geodetic 2 field or O‐lab OK
GPS Antenna 5876 Trimble SPS MSK C02 OK
GPS Antenna 8365 Ashtech Geodetic 4 field or O‐lab OK
GPS Pathfinder field device cable XXX9 Trimble C‐02‐001 (FWD Survey Stores) with GPS Pathfinder OK
GPS Receiver 225111655 Trimble DSM‐232RS CD0001697422 C02 OK
GPS Receiver ZE1200339016 Ashtech Z‐Xtreme CD0001062363 field or O‐lab OK
GPS Reciever 4910K61054 Trimble NetR5 CD0001526973 field or O‐lab OK
GPS Reciever 5034K69677 Trimble NetR9 CD0001709320 field or O‐lab OK
GPS Reciever 5034K69698 Trimble NetR9 CD0001709319 field or O‐lab OK
GPS RTK Receiver 225111661 Trimble DSM‐232 CD0001697439 C02 OK
GPS RTK Reciver 220339262 Trimble MS 750 CD0001478898 C02 OK
Handheld data collector 37318 Trimble TSCe S220 O‐lab, Backpack OK
Hard Drive Dock 1 XXX10 Nexstar OK
Hard Drive Dock 2 XXX11 Nexstar OK
Hard Drive Dock 3 XXX12 Nexstar OK
Hard Drive Dock 4 XXX13 Nexstar OK
Hassler Heavyweight K5K 244 Klein 5000 ‐ Towfish NOAA Ship Fairweather S220 Transferred to FA OK
Heavyweight K5K 293 Klein 5000 ‐ Towfish CD0000825404 NOAA Ship Fairweather S220 placed in operation on fantail of ship OK
K5K‐ TPU 117633 Klein 5000 ‐ TPU CD0001527021 FA Launch 2805 Installed for Arctic Project 2011 OK
K5K‐ TPU 119307 Klein 5000 ‐ TPU CD0001709343 NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
K5K‐ TPU 130144 Klein 5000 ‐ TPU CD0001527022 NOAA Ship Fairweather S220 Installed in Dive Lab OK
K5K‐ TPU Hassler‐TPU Klein 5000 ‐ TPU CD0001722042 C‐11‐001 (AFT Survey Stores) Transferred to FA OK

Laser 000676 Laser Tech Inc.
TruPulse 200 Laser 
Rangefinder

field or O‐lab OK



Laser 001481 Laser Tech Inc.
TruPulse 200 Laser 
Rangefinder

field or O‐lab OK

Laser 041156 Laser Tech Inc.
TruPulse 200 Laser 
Rangefinder

field or O‐lab OK

Laser 041169 Laser Tech Inc.
TruPulse 200 Laser 
Rangefinder

field or O‐lab OK

Laser i09290 Laser Tech Inc. Impulse Laser Rangefinder  CD0001269812 field or O‐lab OK

Level 100056 Carl Zeiss N12 333 O‐Lab OK
Level 103267 Carl Zeiss N12 333 O‐Lab vfd for HSRR 2012 OK
Level 5332739 Leica NA2 100 stored in O‐lab OK
Level 5332747 Leica NA2 100 stored in O‐lab OK
Lightweight K5K 321 Klein 5000 ‐ Towfish NOAA Ship Fairweather S220 vfd in HSRR 2012 OK
Micro Thermosalinograph 4536628‐0117 Sea‐Bird SBE 45 (TSG) Lodar room OK
MVP‐ Fish 10329 Brooke Ocean Technology Inc. MVP‐FFF‐SS‐32‐1 NOAA Ship Fairweather S220 spare‐ vfd for HSRR 2012 OK
MVP‐ Fish 10478 Brooke Ocean Technology Inc. MVP‐FFF‐SS‐32‐1 NOAA Ship Fairweather S220 Current Fish in Use OK
MVP‐ Fish Sensor 4986 Applied Micro Systems Ltd. AML Smart SV +P NOAA Ship Fairweather S220 Installed on fish‐ In Use OK
MVP‐ Fish Sensor 5229 Applied Micro Systems Ltd. AML Smart SV +P NOAA Ship Fairweather S220 In use in MVP. OK
MVP‐ Fish Sensor 5466 Applied Micro Systems Ltd. AML Smart SV +P NOAA Ship Ferdinand Hassler S250 OK
MVP‐200 10328 Brooke Ocean Technology Inc. MVP‐C1‐2001 NOAA Ship Fairweather S220 New system install in MRP OK
MVP‐200 10330 ODOM Brooke Ocean MVP‐C1‐2001 CD0001269854 Plot 1 vfd for HSRR 2012 Needs Service
NMEA/RTCM cable XXX6 Trimble OK
ODOM Echotrac CVM 26034 ODOM Hydrographic Systems Echotrac CVM‐A CD0001703210 O‐Lab vfd for HSRR 2012 OK
O‐Lab 1H7CWK1 DELL Precision T3400 CD0001766765 O‐Lab  Now used for O‐lab computer. OK
P1 GV1ZSR1 DELL Precision T3500 CD0001775172 Plot 1 New computer put into service as P1 OK
P2 GV1SSR1 DELL Precision T3500 CD0001775170 Plot 1 New computer put into service as P2 OK
P3 GV1VSR1 DELL Precision T3500 CD0001775165 Plot 1 New computer put into service as P3 OK
P4 3MD5KN1 DELL Precision T3500 CD0001684477 Plot 1 P4‐ vfd for HSRR 2012 OK
P5 5N54KN1 DELL Precision T3500 CD0001684476 Plot 1 P5‐ vfd for HSRR 2012 OK
P6 GV1RSR1 DELL Precision T3500 CD0001775166 Plot 1 New computer put into service as P6 OK

P6/Proc4‐P3 JG7CWK1 DELL Precision T3400 CD0001766764 F‐06‐002 (Server Room) P6‐ to be renamed and moved to DP3 after Fishpac OK

P7 3MD4KN1 DELL Precision T3500 CD0001684478 Plot 1 P7‐ vfd for HSRR 2012 OK
P8 GV1YSR1 DELL Precision T3500 CD0001775171 Plot 1 New computer put into service as P8 OK

P8/Proc3‐P3 GZ55ZK1 DELL Precision T3400 CD0001766791 F‐06‐002 (Server Room) P8‐ to be renamed and moved to DP3 after Fishpac OK

P9 GV23TR1 DELL Precision T3500 CD0001775169 Plot 1 New computer put into service as P9 OK
Penetrometer 10416 Brooke Ocean Technology Inc. FFCPT‐35‐2 Not found on FA Kept at WRC by FishPac OK
Penetrometer sensor 191‐3 Brooke Ocean Technology Inc. AML SV +P Not found on FA Kept at WRC by FishPac OK
POS MV Antenna 60145158 Trimble OEM2 3151R Matrix OK
POS MV Antenna 60268090 Timble OEM2 3151R Matrix OK
POS MV IMU 007 Applanix CD00001709318 ET stores D02 OK
POS MV IMU 037 Applanix LN200 CD0000832907 C‐02‐001 Spare for 2012 Field Season OK
POS MV IMU 047 Applanix LN200 CD0000825306 FOO stores OK
POS MV IMU 292 Applanix LN200 CD0001696450 NOAA Ship Fairweather S220 New System Install OK
POS MV IMU 294 Applanix LN200 CD0001696449 FA Launch 2805 Installed on New launch OK
POS MV IMU 323 Applanix LN200 FOO stores OK
POS MV IMU 324 Applanix LN200 CD0001722041 C‐02‐001 Spare for 2012 Field Season OK
POS MV IMU 991 Applanix LN200 CD0001722214 FA Launch 2808 vfd for HSRR 2012 OK
POS MV IMU 995 Applanix LN200 CD0001530026 FOO Stores OK
POS MV PCS (V4) 2411 Applanix POS‐MV 320 v4 CD0001697462 FA Launch 2808 vfd for HSRR 2012 OK

POS MV PCS (V4) 2560 Applanix POS‐MV 320 v4 CD0001601274
HW2.6‐7, SW04.22, POS 
Cntrlr v. 4.3.4.0

FA Launch 2808 Upgraded to Internal logging and moved. OK

POS MV PCS (V4) 2564 Applanix POS‐MV 320 v4 CD0001601275
HW2.6‐7, SW04.22 , POS 
Cntrlr v. 4.3.4.0

C‐02‐001 Spare for 2012 Field Season OK

POS MV PCS (V4) 3627 Applanix POS‐MV 320 v4  CD0001527797
HW4.1‐7, SW04.22, POS 
Cntrlr v. 4.3.4.0

NOAA Ship Fairweather S220 WAAS Cabable. No internal logging. OK

POS MV PCS (V4) 3628 Applanix POS‐MV 320 v4 CD0001527796
HW4.1‐7, SW05.01, POS 
Cntrlr v. 5.1.0.2

FA Launch 2805 Upgraded to Internal logging. Moved to launch. OK

POS MV Port Antenna 1440904133 Trimble Zephyr II NOAA Ship Fairweather S220 New Equipment Install OK
POS MV Port Antenna 1440904832 Trimble Zephyr II FA Launch 2808 OK
POS MV Port Antenna 1440925095 Trimble Zephyr II C‐02‐001 Spare for 2012 Field Season OK
POS MV Port Antenna 31171727 Trimble Zephyr II FA Launch 2805 New System Install OK
POS MV Port Antenna 60078644 Trimble Zephyr I C‐02‐001 Spare for 2012 Field Season OK
POS MV Stbd Antenna 1440912566 Trimble Zephyr II C‐02‐001 Spare for 2012 Field Season OK
POS MV Stbd Antenna 1440941041 Trimble Zephyr II FA Launch 2808 OK
POS MV Stbd Antenna 31180200 Trimble Zephyr II NOAA Ship Fairweather S220 New Equipment Install OK
POS MV Stbd Antenna 31185275 Trimble Zephyr II FA Launch 2805 New System Install OK



POS MV Stbd Antenna 60125191 Trimble Zephyr I C‐02‐001 Spare for 2012 Field Season OK
POS MV Stbd Antenna 60130644 Trimble Zephyr I Unknown Failure. Removed from service Transferred
Position Data Link High Powered Base 
Unit

0424 0171 Pacific Crest PDL 4135 CD0001269910 C02 OK

Position Data Link Rover 03473047 Pacific Crest PDL 4100 CD0001269912 C02 OK
Position Data Link Rover 04240154 Pacific Crest PDL 4100 CD0001269896 C02 OK
Position Data Link Rover 04240155 Pacific Crest PDL 4100 CD0001269911 C02 OK
Position Data Link Rover 07095939 Pacific Crest PDL 4101 C02 OK
Proc1‐P2 DHKCZF1 DELL Precision T3400 CD0001615470 Plot 2 Proc1‐P2‐ relocated from FOO desk OK
Proc1‐P3 FJKBZK1 DELL Precision T3400 CD0001766914 Plot 3 Proc1‐P3‐ vfd for HSRR 2012 OK
Proc2‐P2? HZ55HK1 DELL Precision T3400 CD0001766792 OK
SBES Transducer TR5138 ODOM Hydrographic Systems SMBB200_9 O‐Lab Purchased OK
SBES Transducer TR5139 ODOM Hydrographic Systems SMBB200_9 O‐Lab Purchased OK
SBES Transducer TR5159 ODOM Hydrographic Systems SMBB200_4A O‐Lab Purchased OK
SBES Transducer TR5162 ODOM Hydrographic Systems SMBB200_4A O‐Lab Purchased OK
SEACAT Profiler 19P36026‐4585 Sea‐Bird SBE 19plus CD0001697254 1.6b NOAA Ship Fairweather S220 vfd for HSRR 2012 OK
SEACAT Profiler 19P36026‐4616 Sea‐Bird SBE 19plus CD0001697264 1.6b Unknown CTD Lost during wreck seach in Newport, OR Lost
SEACAT Profiler 19P36026‐4617 Sea‐bird SBE 19plus CD0001697251 1.6b NOAA Ship Fairweather S220 vfd for HSRR 2012 for launch use OK
SEACAT Profiler 19P50959‐6121 Sea‐bird SBE 19plus V2 CD0001527777 2.3 NOAA Ship Fairweather S220 vfd for HSRR 2012 for launch use OK
SEACAT Profiler 19P50959‐6122 Sea‐bird SBE 19plus V2 CD0001527778 2.2c C‐02‐001 vfd for HSRR 2012‐ In storage for use in 2013 OK
Solar Charger 0702EPRC5‐026 PWM EPRC5 stored O‐lab OK
Solar Charger 10190177 Morningstar SS‐10‐L. 12v field or O‐lab OK
Solar Charger 10190178 Morningstar SS‐10‐L. 12v field or O‐lab OK
Solar Charger 10190179 Morningstar SS‐10‐L. 12v field or O‐lab OK
Solar Charger 10331024 Morningstar SS‐10‐L. 12v field or O‐lab OK
Solar Charger 1 XXX1 PWM EPRC5 323 SPARE (C‐02 STORES) OK
Solar Charger 2 XXX2 PWM EPRC5 OK
Solar Panel 146624 Sunlinq P3‐12V‐60 field or O‐lab OK
Solar Panel 146636 Sunlinq P3‐12V‐60 field or O‐lab OK
Solar Panel 525‐011093 Uni‐Solar MBC‐525 CD000684507 field or O‐lab OK
Solar Panel 525‐011589 Uni‐Solar MBC‐525 CD000684510 field or O‐lab OK
Solar Panel 525‐011607 Uni‐Solar MBC‐525  CD000684512 field or O‐lab OK

Solar Panel
C30G2005062100
63

GE Energy GEPV‐030‐MNA‐001 stored O‐lab OK

Solar Panel USF‐32‐14529 Uni‐Solar FLX‐32 field or O‐lab OK
Solar Panel USF‐32‐14625 Uni‐Solar FLX‐32 field or O‐lab OK
Solar Panel USF‐32‐14631 Uni‐Solar FLX‐32 field or O‐lab OK
Solar Panel USF‐32‐14633 Uni‐Solar FLX‐32 field or O‐lab OK
Solar Panel USF‐32‐14634 Uni‐Solar FLX‐32 field or O‐lab OK
Solar Panel USF‐32‐14639 Uni‐Solar FLX‐32 field or O‐lab OK
Solutions Dongles KEB2077 Ashtech 600586 (A) missing OK
Solutions Dongles KEB2083 Ashtech 600586 (A) CST desk OK
StarFire GPS Antenna 7020 NavCom AN‐2004T ocation entry C02 OK
StarFire GPS Receiver 5012 NavCom SF‐2050R CD0001697402 Plot 1 OK
StarFire GPS Receiver 5086 NavCom SF‐2050G CD0001699203 Location entry C02 OK
SVP‐ 70 4008077 Reson SVP‐70 NOAA Ship Fairweather S220 New system install Needs Service
SVP‐ 70 4111053 Reson SVP‐70 Plot 1 Fleet Spare received for backup
SVP‐ 71 2008017 Reson SVP‐71 FA Launch 2808 New system install OK
SVP‐71 2008016 Reson SVP‐71 F‐05‐002 (ET Shop) Spare OK
SVP‐71 2008024 Reson SVP‐71 FA Launch 2805 New system install OK
SVP‐71 2008038 Reson SVP‐71 CD0001776104 F‐05‐002 (ET Shop) Spare OK
Trimble Backpack 1 0224078543 Trimble Pathfinder Pro XRS  CD0001269835 Firmware v1.96 RevA O‐Lab Can be on the Field OK
Trimble Backpack 1: Antenna 0220341062 Trimble 33580‐50 field or O‐lab OK
Trimble Backpack 2 0224090101 Timble Pathfinder Pro XRS  CD0001269836 Firmware v1.96 RevA field or O‐lab OK
Trimble Backpack 2: Antenna 0220321059 Timble 33580‐50 field or O‐lab OK
UHF Antenna N/A PCTEL MAX9053 S220 OK
UHF Radio 884‐9190 FreeWave HTP‐900RE CD0001526971 S220 OK
UHF Radio 884‐9301 FreeWave HTP‐900RE (P004369) 2808 OK
UHF Radio 884‐9511 FreeWave HTP‐900RE (P004370) field or O‐lab OK
UHF Radio 885‐8156 FreeWave HTP‐900RE CD0001709328 SPARE (C‐02 STORES) (2806) OK
UHF Radio 885‐8689 FreeWave HTP‐900RE SPARE (C‐02 STORES) (2807) OK
UHF Radio 885‐8740 FreeWave HTP‐900RE CD0001709330 2805 OK
UHF Radio 886‐0744 FreeWave HTP‐900RE CD0001526976 field or O‐lab OK
UHF Radio 886‐0745 FreeWave HTP‐900RE CD0001526975 field or O‐lab OK
UHF Radio XXX3 PCTEL MAX9053 OK
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Machine Name

FA-Proc1 Plot Room 2016 Mission- In Use

Plot Room 2016 Mission- In Use

Plot Room 2016 Mission- In Use

Plot Room Dell Precision T3500 Win 7 Pro Winter 2011 2015 3.33 GHz 12 GB 2 3MD5KN1 CD0001684477 Mission- In Use

Plot Room Dell Precision T3500 Win 7 Pro Winter 2011 2015 3.33 GHz 12 GB 2 5N55KN1 CD0001684476 Mission- In Use

Plot Room 2016 Mission- In Use

Plot Room Dell Precision T3500 Win 7 Pro Winter 2011 2015 3.33 GHz 12 GB 2 3MD4KN1 CD0001684478 Mission- In Use

Plot Room 2016 Mission- In Use

Plot Room 2016 Mission- In Use

Field Office Dell Precision T3400 XP Pro 2002 SP3 Summer 2010 2014 3.33 GHz 3 GB 2 512 MB DJKBZK1 CD0001766913 Non-Mission In Use

Field Office Dell Precision T3400 XP Pro 2002 SP3 Summer 2010 2014 3.33 GHz 3 GB 2 512 MB 7G7CWK1 CD0001766754 Non-Mission In Use

O-Lab Dell Precision T3400 XP Pro 2002 SP3 Spring 2008? - - 3.0 GHz 3 GB 2 512 MB 4JKCZF1 CD0001615469 In Use

Plot Room 2 Dell Precision T3400 XP Pro 2002 SP3 Spring 2008? - - 3.0 GHz 3 GB 2 512 MB 4JKCZF1 CD0001615470 In Use

Plot Room 3 Dell Precision T3400 XP Pro 2002 SP3 Summer-09 2013 3.33 GHz 3 GB 2 512 MB FJKBZK1 CD0001766914 Mission- In Use

Plot Room 3 Dell Precision T3400 XP Pro 2002 SP3 Summer-09 2013 3.33 GHz 3 GB 2 512 MB JG7CWK1 CD0001766764 Mission-Storage

Plot Room 3 Dell Precision T3400 XP Pro 2002 SP3 Summer-09 2013 3.33 GHz 3 GB 2 512 MB GZ55K1 CD0001766791 Mission-Storage

Plot Room 3 Dell Precision T3400 XP Pro 2002 SP3 Summer-09 2013 3.33 GHz 3 GB 2 512 MB HZ55ZK1 CD0001766792 Mission- In Use

ET Office Panasonic   CF-18 XP Pro 2002 SP2 ~ March 2004 - ~ July 2006 1.1 GHz 2.5 GB 1 64 MB 4HKSA59499 CD0001269860 Not For Survey

Laptop Panasonic  CF-18 XP Pro 2002 SP2 ~ March 2004 - ~ September 2007 1.1 GHz 2.5 GB 1 64 MB 4HKSA59560 CD0001269858 In Use

Laptop Panasonic  CF-29 XP Pro 2002 SP2 March 2006 - 1.6 GHz 2.5 GB 1 128 MB 6AKSB06863 CD0001698251 In Use

Laptop Panasonic CF-30 XP Pro 2002 SP3 March 2009 - 1.7 GHz 1 Gb 0 384 MB 8HKSB80630 CD0001447100 In Use

Laptop Panasonic CF-30 XP Pro 2002 SP3 March 2009 - 1.7 GHz 1 Gb 0 384 MB 8HKSB80631 CD0001447101 In Use

Laptop Panasonic CF-19 XP Pro 2002 SP3 March 2009 - 1.1 GHz 1 Gb 1 384 MB 9AKSB43281 CD0001696424 In Use

Laptop Dell Precision M4400 XP Pro 2002 SP3 3.0 GHz 3.5 Gb 1 512 MB 8L56ZK1 CD0001766841 In Use

Launch 2805 Cybertron PC ACP-4000 XP Pro 2002 SP3 2014 2.0 GHz 3 GB 2 1024 MB 40001000160709 CD0001703148 In Use

Launch 2806 Cybertron PC ACP-4000 XP Pro 2002 SP3 2014 2.0 GHz 3 GB 2 1024 MB 40001000160707 CD0001703147 Storage

Launch 2807? Cybertron PC ACP-4000 XP Pro 2002 SP3 2014 2.0 GHz 3 GB 2 1024 MB 40001000160711 CD0001703146 Storage

Launch 2808 Cybertron PC ACP-4000 XP Pro 2002 SP3 2014 2.0 GHz 3 GB 2 1024 MB 4000100016078 CD0001703149 In Use

Plot Room Dell Precision T3400 XP Pro 2002 SP2 Mar-08 2012 3.0 GHz 3 GB 3 512 MB CSH8NF1 CD0001615444 In Use

Plot Room Dell Precision T3400 XP Pro 2002 SP3 Summer-09 2013 3.33 GHz 3 GB 2 512 MB HG7LWK1 CD0001766763 In Use

Plot Room MVP-C1-2001 2000 SP4 ~ March 2004 - ~ May 2012 2.4 GHz 230 MB 1 64 MB SN: 10330 CD0001269854
In Use

Plot Room Dell Precision T3400 XP Pro 2002 SP3 Apr-08 Removed 2012 3.0 GHz 3 GB 2 512 MB 3JKCZF1 CD0001615472
Removed

Plot Room Dell Precision T3400 XP Pro 2002 SP3 Apr-08 Removed 2012 3.0 GHz 3 GB 2 512 MB TJKCZF1 CD0001615471 f 04/06/08, Not installed as of 6/3/10
Removed

O-Lab Dell Precision 490 XP Pro 2002 SP3 Nov-07 Removed 2012 2.66 GHz 3 GB 2 256 MB 2NP1PD1 CD0001615380
Removed

Plot Room 2 Dell Precision T3400 XP Pro 2002 SP3 Apr-08 Removed 2012 3.0 GHz 3 GB 2 512 MB JHKCZF1 CD0001615468
Removed

Plot Room 3 Dell Precision 490 XP Pro 2002 SP3 Nov-07 Removed 2012 2.66 GHz 3 GB 2 256 MB 8MP1PD1 CD0001615384
Removed

Plot Room 3 Dell Precision 490 XP Pro 2002 SP3 Nov-07 Removed 2012 2.66 GHz 3 GB 2 256 MB 9MP1PD1 CD0001615385
Removed

FA-Proc9

FA_Proc_10

FA-OLab

FA_P2_Proc1

Old Work Stations Removed May 2012

FA-Proc1

FA-Proc2

FA-Proc6

FA-Proc7 Windows 7 64 Bit

FA-Proc8

FA-Proc3

FA-Proc4 Windows 7 64 Bit

FA-Proc5 Windows 7 64 Bit

Moved from FA-CST 5/2012- Unsupported by EEBFA-OLab

FA_P2_Proc1 Moved from FA-FOO 5/2012-  Unsupported by EEB

FA-Proc9

FA-CST  Moved from FA-Proc2 5/2012- Not Refreshed by OCS, but EEB

FA-FOO Moved from FA-Proc3 5/2012- Not Refreshed by OCS, But EEB

FA_P3_Proc4

Toughbook 1 ET Office

Toughbook 2 Tides ToughBook- In disrepair

FA_P3_Proc1

FA_P3_Proc2 Moved from FA-Proc6 5/12

FA_P3_Proc3 Moved from FA-Proc8 5/12

Toughbook 5

Survey Mobile Workstation

2805_ACQ P/N ACP-4000MB-00XE

Toughbook 3 In Need of Replacement

Toughbook 4

Toughbook 6

S220_ACQ Overdue for Replacement

FA_MVP200

2806_ACQ P/N ACP-4000MB-00XE

2807_ACQ P/N ACP-4000MB-00XE

2808_ACQ P/N ACP-4000MB-00XE

S220_ACQ2 New Dell desktop installed March 2010

Dell desktop installed week of 04/06/08

Dell desktop installed week of 12/4/07, Moved 03/2010

Dell desktop installed week of 04/06/08

Dell desktop installed week of 12/4/07, Moved 03/2010

Refreshed 02/2010, 12/4/07, Moved 03/2010

FA_P3_Proc2

FA_P3_Proc3



 

AML Oceanographic 
2071 Malaview Avenue, Sidney B.C.   V8L 5X6   CANADA 

T: +1-250-656-0771   F: +1-250-655-3655   Email: service@AMLoceanographic.com 

Certificate of Calibration 

 
Customer:    

Asset Serial Number:   

Asset Product Type:    

Calibration Type: 

Calibration Range: 

Calibration RMS Error: 

Calibration ID:  

Installed On: 

 

 
Coefficient A: 

Coefficient B: 

Coefficient C: 

Coefficient D: 

Coefficient E: 

Coefficient F:

Coefficient G: 

Coefficient H: 

Coefficient I: 

Coefficient J: 

Coefficient K: 

Coefficient L: 

Coefficient M: 

 

 
Calibration Date (dd/mm/yyyy):   

Certified By: 

 
Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 
traceable standards.  Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this 
calibration certificate will still be valid when used on other such assets.  If this instrument or sensor has been recalibrated, 
please be sure to update your records.  Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary.   Older generation instruments may require configuration files, which are 
available for download at our Customer Centre at www.AMLoceanographic.com/support 

http://www.amloceanographic.com/support�


 

AML Oceanographic 
2071 Malaview Avenue, Sidney B.C.   V8L 5X6   CANADA 

T: +1-250-656-0771   F: +1-250-655-3655   Email: service@AMLoceanographic.com 

Certificate of Calibration 

 
Customer:    

Asset Serial Number:   

Asset Product Type:    

Calibration Type: 

Calibration Range: 

Calibration RMS Error: 

Calibration ID:  

Installed On: 

 

 

Coefficient A: 

Coefficient B: 

Coefficient C: 

Coefficient D: 

Coefficient E: 

Coefficient F:

Coefficient G: 

Coefficient H: 

Coefficient I: 

Coefficient J: 

Coefficient K: 

Coefficient L: 

Coefficient M: 

 

 
Calibration Date (dd/mm/yyyy):   

Certified By: 

 
Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 
traceable standards.  Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this 
calibration certificate will still be valid when used on other such assets.  If this instrument or sensor has been recalibrated, 
please be sure to update your records.  Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary.   Older generation instruments may require configuration files, which are 
available for download at our Customer Centre at www.AMLoceanographic.com/support 

NOAA - Pacific Marine Center

004986

Smart SV&P for Brooke MVP -

Sound Velocity

1400 to 1550 m/s

.0221

004986 999999 S00379 050112 213258

1.521097E+3 0.000000E+0

-1.067196E+2 0.000000E+0

8.855808E+0 0.000000E+0

-1.015399E+0 0.000000E+0

0.000000E+0 0.000000E+0

0.000000E+0 0.000000E+0

0.000000E+0

5/1/2012









 

AML Oceanographic 
2071 Malaview Avenue, Sidney B.C.   V8L 5X6   CANADA 

T: +1-250-656-0771   F: +1-250-655-3655   Email: service@AMLoceanographic.com 

Certificate of Calibration 

 
Customer:    

Asset Serial Number:   

Asset Product Type:    

Calibration Type: 

Calibration Range: 

Calibration RMS Error: 

Calibration ID:  

Installed On: 

 

 

Coefficient A: 

Coefficient B: 

Coefficient C: 

Coefficient D: 

Coefficient E: 

Coefficient F:

Coefficient G: 

Coefficient H: 

Coefficient I: 

Coefficient J: 

Coefficient K: 

Coefficient L: 

Coefficient M: 

 

 
Calibration Date:   

Certified By: 

 
Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 
traceable standards.  Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this 
calibration certificate will still be valid when used on other such assets.  If this instrument or sensor has been recalibrated, 
please be sure to update your records.  Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary.   Older generation instruments may require configuration files, which are 
available for download at our Customer Centre at www.AMLoceanographic.com/support 

NOAA - Pacific Marine Center

005466

Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Pressure

1000 dBar

.0363

005466 999999 0UE855 221210 181408

-1.239801E+3 -1.128182E-6

-3.145002E-1 1.415759E-8

3.012141E-2 -5.470870E-9

-3.571170E-4 -1.925685E-10

4.406489E-2 1.080000E-11

2.278661E-5 -1.832266E-13

22/12/2010



 

AML Oceanographic 
2071 Malaview Avenue, Sidney B.C.   V8L 5X6   CANADA 

T: +1-250-656-0771   F: +1-250-655-3655   Email: service@AMLoceanographic.com 

Certificate of Calibration 

 
Customer:    

Asset Serial Number:   

Asset Product Type:    

Calibration Type: 

Calibration Range: 

Calibration RMS Error: 

Calibration ID:  

Installed On: 

 

 

Coefficient A: 

Coefficient B: 

Coefficient C: 

Coefficient D: 

Coefficient E: 

Coefficient F:

Coefficient G: 

Coefficient H: 

Coefficient I: 

Coefficient J: 

Coefficient K: 

Coefficient L: 

Coefficient M: 

 

 
Calibration Date:   

Certified By: 

 
Robert Haydock 

President, AML Oceanographic 
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to 
traceable standards.  Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this 
calibration certificate will still be valid when used on other such assets.  If this instrument or sensor has been recalibrated, 
please be sure to update your records.  Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary.   Older generation instruments may require configuration files, which are 
available for download at our Customer Centre at www.AMLoceanographic.com/support 

NOAA - Pacific Marine Center

005466

Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Sound Velocity

1400 to 1550 m/s

.0202

005466 999999 140294 141210 195516

1.534096E+3 0.000000E+0

-1.129699E+2 0.000000E+0

9.133756E+0 0.000000E+0

-7.934285E-1 0.000000E+0

0.000000E+0 0.000000E+0

0.000000E+0 0.000000E+0

14/12/2010



























































SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 
sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 
performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-
functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 67182

Model Number SBE 19Plus

Date of Report: 1/9/2012

Serial Number: 19P50959-6122

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 
conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 
sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 
corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 
repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/7/2012 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: 0.0000 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 6122
CALIBRATION DATE: 07-Jan-12

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:
g = -9.958156e-001
h =  1.574233e-001
i = -5.789094e-004
j =  6.973901e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 
 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL
       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2523.26     0.0000      0.00000
   1.0522    34.9247    2.98888    5049.51     2.9889      0.00001
   4.5393    34.9046    3.29577    5239.93     3.2958      0.00000
  14.9999    34.8606    4.27646    5805.91     4.2764     -0.00003
  18.5000    34.8509    4.62246    5992.56     4.6225     -0.00001
  24.0000    34.8403    5.18180    6282.24     5.1818      0.00002
  29.0000    34.8342    5.70492    6541.17     5.7050      0.00003
  32.5000    34.8310    6.07826    6719.61     6.0782     -0.00003
 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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16-Dec-10 1.0000035
07-Jan-12 1.0000000



Customer: Pacific Marine Center / NOAA

Job Number: 67182

Model Number SBE 19Plus

Date of Report: 1/9/2012

Serial Number: 19P50959-6122

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/7/2012 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00155 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  
If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 
must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 
during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 
drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 
subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 6122
CALIBRATION DATE: 06-Jan-12

SBE19plus PRESSURE CALIBRATION DATA
  870 psia S/N 2752080

 
COEFFICIENTS:
PA0 =   -1.595168e-001

PA1 =    2.635889e-003

PA2 =    1.988748e-011

PTEMPA0 = -6.221592e+001

PTEMPA1 =  5.462283e+001

PTEMPA2 = -5.399299e-001

PTCA0 =  5.244075e+005

PTCA1 = -1.948655e+000

PTCA2 = -5.273420e-002

PTCB0 =  2.507825e+001

PTCB1 = -5.500000e-004

PTCB2 =  0.000000e+000

 
  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION
  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST
         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.75 529997.0   1.5       14.75  -0.00         32.50     1.76   530082.73
  180.02 592632.0   1.6      180.02   0.00         29.00     1.70   530102.94
  360.01 660768.0   1.6      359.98  -0.00         24.00     1.60   530126.87
  530.01 725071.0   1.6      529.99  -0.00         18.50     1.50   530149.57
  719.99 796861.0   1.6      719.99   0.00         15.00     1.43   530162.55
  874.96 855352.0   1.6      874.94  -0.00          4.54     1.24   530187.58
  720.00 796880.0   1.6      720.04   0.00          1.05     1.17   530204.98
  530.04 725097.0   1.6      530.06   0.00
  360.05 660792.0   1.6      360.05   0.00         TEMP(ITS90)   SPAN(mV)
  180.07 592649.0   1.6      180.07   0.00            -5.00       25.08
   14.75 529999.0   1.6       14.76   0.00            35.00       25.06
 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Pressure Test Certificate

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Customer Pacific Marine Center / NOAA

Job Number 67182

Date 1/5/2012

Technician JK

Serial Number 19P50959-6122

Replaced the main piston "O"-Rings.

50

500

15

30

Pass

Comments

Fail

Low Pressure (PSI)

High Pressure (PSI)

Time (Minutes)

Time (Minutes)

PSI

PSI

Minutes

Minutes

Time

Pressure

Typical Test Profile

High pressure is generally equal

to the maximum depth rating of 

the instrument.
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SVP Test and Calibration certificate

SVP Type : SVP70 Date of issue : 01-04-2009

SVP Serial No. 4008077

Functionality Test : Sign : ___________________________

Temperature Calibration : Hart 1504 s/n A6B554 & Thermistor s/n 3014

Point 1: 4.6 °C

Point 2: 16.5 °C

Point 3: 25.5 °C

Pressure Calibration : Custom Built Tank (TestUnit ASF150 Ser# 41-10-0007-R03)

Point 1: 0 Bar

Point 2: 301.7 Bar

Point 3: 603.6 Bar

RMS Speed of Sound Errors

Temperature Validation : 0.0033 m/s

Pressure Validation : 0.0845 m/s

Calibration Completed : Sign : ___________________________

Final Function Test : Sign : ___________________________

QA Signature : Inits : ______________













Appendix II 
 
 
Vessel Reports, Offsets, and Diagrams 
 
Launch 2805 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 

 
Launch 2808 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 

 
S220 

1. Offsets 
2. Static Draft 
3. Vessel Report 

a. Survey Report 3/2009 
b. Stability Report 7/2004 
c. Survey Report 9/2003 

4. Patch Test 
5. POS MV GAMS Calibration 
6. Dynamic Draft 

 
Coordinate Systems Utilized in Vessel Offsets



2805 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.004 0.686 n/a Scaler Distance 1.447 -0.682 -0.806 0.000 0.000
y 0.000 0.245 1.051 n/a -0.806 -0.682 0.000 0.000
z 0.000 0.482 3.656 -0.097 -3.174 -3.174 0.000 0.000

*IMU is Reference Point -0.111

Vessel Offsets for 2805 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2011 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.68217 RP to Waterline (m) IMU to x -0.68217 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.80598 z 0.097 Port Ant (m) y -0.80598 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.17407 (calculated) z 3.17407 z 0.00000 z 0.00000

MBES RP x 0.00401 IMU to 7125 x 0.00401 IMU (m) x, y, z 0.00000 Top of x -0.68217 Heave Pt (m)   x 0.00000
Rcvr - Phase (m)      y 0.24503 Phase Ctr y 0.24503 2010 RP to Waterline (m) Port Ant (m)  y -0.80598 (by design) y 0.00000
Center z -0.48191 (calculated) z -0.48191 z 0.111 Top of x 0.76454 z 3.16277 z 0.00000

Stbd Ant (m)  y -0.80778
z 3.14528 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.08977
Bottom of Stbd Ant
(calculated) (m)  z 3.07228 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to 7125 x 0.00401 x 0.68618 x n/a x -0.68217 x 0.00000

Phase Ctr y 0.24503 y 1.05101 y n/a Scalar Distance 1.4468 y -0.80598 y 0.00000
z -0.48191 z -3.65598 z 0.097 z 3.17407 z 0.00000

Coord. Sys. x 0.00401 Coord. Sys. x 0.68618 Coord. Sys. x n/a Coord. Sys. x ‐0.80598 Coord. Sys. x 0.00000
CARIS y 0.24503 CARIS y 1.05101 CARIS y n/a Pos/Mv y ‐0.68217 Pos/Mv y 0.00000

z 0.48191 z 3.65598 z ‐0.097 z ‐3.17407 z 0.00000

(2010 used for K5K)

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave



2012 2011 Measured Values

Measurement IMU 
aka to RP*
Coord. Sys. Caris Caris Caris
x 0.000 0.534 0.609
y 0.000 0.845 -5.525
z 0.000 0.772 -2.186

*IMU is Reference Point

Vessel Offsets for 2805 K5K are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 y 0.00000

z 0.00000 z 0.00000

KEEL FORE BM x -0.00202 Centerline Stern BM x -0.01735
y 0.44007 y -4.04803
z -0.6141 z 0.67574

KEEL FORE BM to K5K CSBM to Tow PT
Rcvr - Phase x 0.536 x 0.626
Center y 0.405 y -1.477

(measured) z -0.158 (measured) z 1.510

Coord. Sys.
NGS IMU to K5K x 0.53398 IMU to Tow PT K5K x 0.60865

Phase Ctr y 0.84507 y -5.52503
z -0.77210 z 2.18574

Coord. Sys. x 0.53398 Coord. Sys. x 0.60865
CARIS y 0.84507 CARIS y ‐5.52503

IMU to K5K

IMU to K5K

IMU to K5K

IMU to Tow PT K5K

IMU to Tow PT K5K

IMU to Tow PT K5K

z 0.77210 z ‐2.18574



Description of Offsets for Launch 2805

All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2805 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.447 m Primary Antenna Reference Pt.
7125 Phase Center

-3.174 m

3.656 m
0.245 m

1.051 m

-0.806 m
Primary Antenna Reference Pt.

0.686 m
Port Ant. to 7125 

-0.682 m

IMU 
Reference 

0.004 m

IMU Reference Pt.

1.447 m

2805

0.845 m

0.534 m

K5K Reference Pt.

0.482 m

0.004 m

7125 Phase 
Center

Pt.

2805
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0 686 m

2805
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.772 m

0.534 m 
K5K Reference Pt.

x y z x y z x y z x y z x y z
0.004 0.245 0.482 0.686 1.051 3.656 N/A N/A -0.097 -0.682 -0.806 -3.174 0.000 0.000 0.000

IMU to Heave
Scalar Distance

1.447

IMU to 7125 Port Ant to 7125 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
th NGS Th h i l

The values were calculated by 
subtracting the physical height 
of the Port Antenna to the IMU x, 

l f h i

The average vertical distance 
from Port Benchmark to 
waterline and the Starboard
B h k t th t li

The location of the IMU and the 
location of the top of port 
antenna were surveyed by NGS.  
The z value of the antenna was

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values

0.686 m 
Port Ant. to 7125 

x y z
0.534 0.845 0.772

IMU to K5K

and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 

subtracting the physical height 
of the Port Antenna to the IMU x, 
y, z values from the respective 
values of the IMU to the 7125.  
The calculated values were then 
transposed from the NGS to the 
CARIS coordinate system.

from Port Benchmark to 
waterline and the Starboard
Benchmark to the waterline were 
measured by FAIRWEATHER 
personnel using a steel tape and 
bubble level.  These values were 
combined with the Z value of the 
Benchmarks to the RP/IMU to get 
an average for the waterline to 
RP.  The Waterline Measurement 
value is in NGS coordinates 
initially and is converted to CARIS 
coordinates.

location of the top of port 
antenna were surveyed by NGS.  
The z‐value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base 
of the antenna to the phase 
center of the antenna. The 
calculation results were then 
transposed from the NGS to the 
CARIS coordinate system. 

POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

The location of the IMU and the 
location of the forward keel  
benchmark were surveyed by 
NGS.  BM to K5K were measured 
by FAIRWEATHER personnel 
using a steel tape and bubble 
l l

7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

initially and is converted to CARIS 
coordinates.

by FAIRWEATHER personnel 
using a steel tape and bubble 
level.



Fill in Yellow squares only!
Measuring Party:

Waterline measurements should be negative and cm!

Date: 3/17/2011
Fuel Level: 101 Gallon

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 -0.0170 -0.0498

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.083

Individual 0.09435 0.03950
measurement 0.12335 0.06150
StDev for TPU xls 0.031 0.10735 0.07450
(of 6 #'s)

Measuring Party: ENS Wilson, ST Francksen, LT Jaskoski, SS Abraham

Date: 3/25/2011
Fuel Level: 68.9 Gallon

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 0.0010 -0.0319

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.097

(Add this value to VSSL_Offsets & Measurements_20XX.xls)

Individual 0.11035 0.08350
measurement 0.11035 0.08550
StDev for TPU xls 0.018 0.11835 0.07450

(of 6 #'s)

Measuring Party:

Date: 4/6/2011
Fuel Level: 30 gallons

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 -0.0467 -0.0795

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.091

Individual 0.13335 0.03550
measurement 0.12935 0.06150
StDev for TPU xls 0.044464 0.13035 0.05750
(of 6 #'s)

Utilized in Offsets and Measurements and TPU spreadsheet

2805

ENS Wilson, ST Francksen, ENS Flowers

Morgan, Loy, Pfundt

1.07535 1.04250

0.108

-94.2 -100.7

-94.6 -98.1

0.131 0.051

-94.43 -99.10

-0.9443 -0.9910

0.00208 0.01400

-94.5 -98.5

1.07535

Waterline Measurements

Waterline measurements should be negative and cm!

2805
Port Benchmark to Waterline Stbd Benchmark to Waterline

1.04250

-98.1

-0.9840

-96.8

-96.70

-0.9670

-96.8

-98.40

2805
Port Benchmark to Waterline Stbd Benchmark to Waterline

-98.1 -100.3

2805

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.059

-95.2

-0.9623

0.01453 0.01769

-0.9613

-96.5 -95.7

-95.7 -96.8

-96.5 -95.9

0.113016667 0.081

Waterline measurements should be negative and cm!

0.00462 0.00586

1.07535 1.04250

-96.23 -96.13
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NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2805.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 26th of 
January, 2010.  The weather was sunny early then cloudy with  temperatures in the 40s to 
50s.  For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.000m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU.  
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 
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Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
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STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMC-  CENTERLINE CAB BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the cab, along the centerline of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 



 
 
 

Appendix A 
 

Coordinate Report Launch 2805 
 
Pt Name      North(Y) East(X) Elev.(Z) ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13270    -0.00348    -0.16937    IMUR  
Centerline Stern BM          -4.04803     0.01735     0.67574     CLS   
Centerline Bow BM    3.46914     0.01735     1.39751     BMB   
Portside GPS Ant. Ref. Point -0.80598    -0.68217     3.16277     GPSP  
Starboard GPS Ant. Ref. Point-0.80778     0.76454     3.14528     GPSS  
Multi-Beam Ref.Point    0.24503     0.00401    -0.48191    MB    
Keel BM      0.44007    -0.00202    -0.61410    MBF   
Keel BM        -0.22895    -0.00227    -0.53363    MBA   
Port Side BM     0.10603    -1.42637     1.07535     BMP   
Starboard Side BM     0.10926     1.45859     1.04250     BMS   
Centerline Cab BM       -0.19024     0.03192     2.65903     BMC 
 
Units = meters 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

Appendix B  
 

Point to Point Inverse Launch 2805 
 

Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
18        31      0.004     -0.003     0.003    -0.00141  BMC  
 9        29      0.001     0.001    - 0.001     0.00051  BMP  
39        49      0.003    -0.003     0.001    -0.00063  BMS  
 8        48      0.001    -0.001    -0.001     0.00016  CLS  
10        30      0.002    -0.001     0.002     0.00033  GPSP  
11        41      0.000     0.000     0.000     0.00034  GPSS  
16        53      0.001     0.000     0.001     0.00024  IMU  
17        54      0.002     0.000    0.002     0.00029  IMUR  
 4        46      0.006     0.005     0.002    -0.00018  MB  
 5        47      0.001     0.000     0.001     0.00016  MBA  
 3        45      0.002     0.001     0.001    -0.00017  MBF 
 
Units = meters 
 
 
 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/14/2012
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/14/2012
Date Dn Local Area Wx

10 to 50

1812027

3/13/2012Applanix POS/MV   S/N:3628      IMU S/N:294

1' seas, wind 5kts, MCLRShillshoal105

Launch 2805 200kHz

SST Francksen, ST Bravo, AST Robinson

2009Hull Mounted

105

7125

Shillshoal

1/26/2012Fixed Hull Mount

Bottom Type Approximate Water Depth

Personnel on board

Comments

1806 26.06
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1931 24
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

2223 25.09
SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2012_105_193159 47/40/25.1N 122/25/22.24W

2012_105_222342 47/40/25.1N 122/25/22.24W

2012_105_2805.000

2012_105_180653

Brooksk, Franksen, Bravo, Robinson 

POSMV Filename(s)

47/40/25.1N 122/25/22.24W



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

130 4.0
303 4.0

2012M_1052035.hsx 125 8.0
305 8.0
135 8.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

303 4.0
128 4.0
305 4.0
128 4.0
305 4.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

140 4.0
303 4.0
140 4.0

hsx Line Filename

2012M_1052038.hsx
2012M_1052042.hsx

2012M_1052102.hsx

2012M_1052057.hsx

2012M_1052100.hsx
XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2012M_1052104.hsx

2012M_1052033.hsx

2012M_1052052.hsx
2012M_1052054.hsx

2012M_1052050.hsx

XTF Line Filename
2012M_1052047.hsx

2012M_1052030.hsx

302 4.0
135 4.0
302 4.0
135 4.0

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

217 4.0
119 4.0

2012M_1052124 217 4.0

2012M_1052109.hsx

2012M_1052105.hsx
2012M_1052107.hsx

_

no induced roll
induced roll
induced roll

2012M_1052112.hsx

XTF Line Filename
2012M_1052116
2012M_1052120



Processing Log

4/14/2012
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.89 -0.41 0.77
0.00 -0.90 -0.35 1.29
0.00 -1.20 -0.34 1.00
0.00 -0.71 -0.40 0.70

105

Data converted --> HDCS_Data in CARIS

CST Beduhn, ENS Madsen

TrueHeave applied

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Zacharias
Loy
MacDonald

2012_105_2805_CONCAT.000.fixed

2012_105_2805.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Beduhn

0.00 -0.93 -0.38 0.94
0.00 0.20 0.04 0.27
0.00 -0.93 -0.38 0.94

MRU Align StdDev gyro 0.27 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.12 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/15/2012

Standard Deviation
FINAL VALUES

FA_2805_200kHz_7125_256bms_2012.hvf

Final Values based on

Averages

Resulting HVF File Name

Tami Beduhn



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/14/2012
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/14/2012
Date Dn Local Area Wx

10 to 50

1812027

3/13/2012Applanix POS/MV   S/N:3628      IMU S/N:294

1' seas, wind 5kts, MCLRShillshoal105

Launch 2805 400kHz

SST Francksen, ST Bravo, AST Robinson

2009Hull Mounted

105

7125

Shillshoal

1/26/2010Fixed Hull Mount

Bottom Type Approximate Water Depth

Personnel on board

Comments

1806 26.06
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1931 24
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

2223 25.09
SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2012_105_193159 47/40/25.1N 122/25/22.24W

2012_105_222342 47/40/25.1N 122/25/22.24W

2012_105_2805.000

2012_105_180653

Brooks, Franksen, Bravo, Robinson 

POSMV Filename(s)

47/40/25.1N 122/25/22.24W



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

142 4.0
303 4.0

2012M_1052140.hsx 130 8.0
306 8.0
130 7.6
305 4.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

138 4.0
305 4.0
140 4.0
303 4.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

306 4.0
132 4.0
306 4.0

hsx Line Filename

2012M_1052141.hsx
2012M_1052143.hsx

2012M_1052150.hsx
2012M_1052148.hsx
XTF Line Filename

2012M_1052144.hsx

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2012M_1052152.hsx

2012M_1052138.hsx

2012M_1052208.hsx
2012M_1052209.hsx

2012M_1052205.hsx

XTF Line Filename
2012M_1052204.hsx

2012M_1052135.hsx

135 4.0
143 4.0
135 4.0

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

240 4.0
118 4.0

2012M_1052219.hsx 282 4.0

2012M_1052158.hsx

2012M_1052146.hsx
2012M_1052156.hsx

_

not induced roll
induced roll
induced roll

XTF Line Filename
2012M_1052211.hsx
2012M_1052215.hsx



Processing Log

4/14/2012
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.90 -0.11 0.88
0.00 -1.09 -0.17 0.96
0.00 -1.07 -0.12 0.96
0.00 -0.90 -0.18 0.75

105

Data converted --> HDCS_Data in CARIS

CST Beduhn, ENS Madsen

TrueHeave applied

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Daniel Smith
Tami Beduhn
Caryn Zacharias

2012_105_2805_CONCAT.000.fixed

2012_105_2805.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Kay MacDonald

0.00 -0.99 -0.15 0.89
0.00 0.10 0.04 0.10
0.00 -0.99 -0.15 0.89

MRU Align StdDev gyro 0.10 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.07 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/15/2012

Standard Deviation
FINAL VALUES

FA_2805_400kHz_7125_512bms_2012.hvf

Final Values based on

Averages

Resulting HVF File Name

Tami Beduhn



Bottom Type:  sandy/muddy

Sub-Locality:  Yaquina River, near the turning basin

Description of Bathymetry:  flat/gently sloping

Date of Current Cable Measurement / Verification (if applicable): March 15th, 2012

Approximate Water Depth:  8-10 m

Description of Target: bouy block

Cable Measurement System (if applicable): marked cable (5m increments)

Date of Current Vessel Offset Measurement / Verification: March 15, 2012

TEST INFORMATION

Wind / Seas / Sky:  Clear skys, light wind

Locality:  Newport, OR

Side Scan Sonar Calibration

Field Unit: Fairweather (S220)

Date of Test: 3/8/2012 (Dn 068)

SIDE SCAN SYSTEM INFORMATION

System Location:  Launch 2805

Side Scan System: Klein System Lightweight 5000

Date of Most Recent EED / Factory Checkout:  Unkown

VESSEL INFORMATION

Sonar Configuration:  Towed

Calibrating Hydrographer(s): Beduhn, Smith, Loy, Cruz

TPU Serial Number:  176

Towfish Serial Number:  321

Cable Type:  Stainless steel armored w/grease termination

Target Position:  44 37 34.01 N 124 02 16.56 W

Description of Positioning Method:  MBES

Estimated Target Position Error:  5m

Approximate Survey Speed:  5-7 kts

Approximate Towfish Altitude:  4-7 m

Approximate Target Size:  (should be approximately 1m L x 1m W x 1m H)

TEST INFORMATION (continued)

Page 1 of 3



Line Number Heading Speed Fish Altitude Range Scale Target Seen?

112 122 4.55 kts 50 m Y

105 298 6.3 kts 50 m Y

111 121 4.4 kts 50 m Y

106 125 4 kts 50 m Y

111 292 7 kts 75 m Y

105 127 5 kts 50 m Y

112 7 m 75 m Y

104 4.5 kts 5-6 m 50 m Y

113 75 m Y

106 4.5 kts 50 m Y

104 75 m Y

110 4.5 kts 6 m 50 m Y

105 7 kts 6 m 75 m Y

109 50 m Y

103 7 kts 75 m Y

113 6.9 kts 75 m Y

111 121 6 kts 100 m Y

105 123 5 kts 100 m Y

112 290 7 kts 7 m 100 m Y

106 126 5 kts 100 m Y

113 298 7 kts 100 m Y

104 126 5 kts 100 m Y

DATA ACQUISITION INFORMATION

104 126 5 kts 100 m Y

106 296 7 kts 100 m Y

111 120 5 kts 6 m 100 m Y

105 296 7.5 kts 7 m 100 m Y

112 120 5.5 kts 7 m 100 m Y

104 293 8 kts 6 m 100 m Y

110 120 5 kts 5 m 100 m Y

Page 2 of 3



Contact  Northing Contact Easting Mean Easting Mean Northing 

0.917 45.506 417602.7706 4941943.314

1.501 45.276

1.183 45.269 1.96Std Dev East'n 1.96Std Dev Nor'n

0.246 45.181 4.02 2.67

2.375 44.765

2.181 44.468 Target Easting Target Northing

6.179 44.395 417601.621 4941943.169

3.468 44.218

0.958 43.772

0.658 43.554

5.397 43.494

1.341 43.334

0.99 43.139

3.655 43.116

1.599 43.031

1.896 42.694

3.23 42.166

2.261 42.045

0.965 42.082

2.45 41.942

5.162 41.863

7.852 41.862

The Target

6.067 41.852

3.963 40.512

Mean Detected Position (Easting and Northing):  417602.77 4941943.31

Distance from Mean Position to True Position (m):  1.16

Approximate 95% Confidence Radius (m): 3.35
NARRATIVE
Three bouy blocks were located in the area of side scan testing. The easternmost one was used for patch testing, however all three showed 

up well in the majorety of the side scan passes. Of the 28 passes, 24 had successful detection well within the allowable accuray of 10 meters. 

Number of Passes on Target:  28

Successful Target Detections:  24

TEST RESULTS

Page 3 of 3



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 2805

Date: 3/13/2012 Dn: 73

Personnel: SS Abraham, ENS Smith, ENS Younkin

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:

Approximate Position: Lat 44 37 39.5

Lon 124 2 52.3

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 287Khz

Satellite Constellation (Use View> GPS Data)

31185275

294

NOAA POS/MV Calibration Report

Yaquina Bay

3628

FT Stevens

31171727

129.100.1.200

2011_068_2805.000
POSMV filename(s)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 2.17 (Use View> GAMS Solution)

Secondary GPS

N



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 1720

End time: 1801

Heading accuracy achieved for calibration: 0.049

Calibration Results:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 2011_116_2806_GAMS

C:\HYPACK 2011\Projects\HSRR_2011\Raw\GNSS_Data\POSMV_Data



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2



COM3

Baud Rate Rate Parity

Output Select

None

Input Select Input

? Input Type

Line

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Heave Bandwidth

Damping Ratio

Events (Use Settings > Events)

1

Positive, Negative Edge Trigger
2

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Time Tag 1 Multi Path
POS Time Low
GPS Time Medium
UTC Time High

Time Tag 2 Auto Start

POS Time Disabled
GPS Time Enabled
UTC Time

User Time

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Reference to Aux. 1 GPS Lever Arm
X (m)
Y (m)
Z (m)

Reference to Sensor 1 Lever Arm
X (m)
Y (m)
Z (m)

Reference to Sensor 2 Lever Arm
X (m)
Y (m) Y (deg)
Z (m) Z (deg)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

RMS Accuracy
Attitude (deg)

Heading (deg)

Position (m)
Velocity (m/s)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Baud Rate Parity Data Stop

Auto Configuration

Enabled

Disabled

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration

Enabled

Disabled

Processing Log

3/13/2012
Date Dn Personnel

See FOO/CST with values

Values

Post Processing of GAMS Calibration

073 ENS Smith

New Values entered in POS View?

Allow decimeter level freedom when processingPOS Pac Processing

Reprocess using new values, but restrict to 10 cm of freedom

Reprocess using new values, again use 10 cm of freedom

Continue itterating until values no longer change

Final Antena Seperation/ Lever Arms Determined



Date: 3/13/2012 Dn: 73

Vessel: 2805

(Project Settings > GNSS-Inertial Processor > Lever Arms and Mounting Angles)
X Y Z

-0.008 -0.031 0.130

X Y Z

-0.77 -0.75 -3.15

X Y Z
Run 1 -0.783 -0.745 -3.159
Run 2 -0.783 -0.745 -3.159
Run 3

1.454

GAMS CalibrationPost-Processing Results

POS File Name: GAMMS_073_CONCAT.000

POSPac Project Name: 2012_073_2805_GAMS.000

Project Location: T:\Testing_2012\Caris\GNSS_DATA

Lever Arm Offsets

Reference to IMU Lever Arm

Starting Value (Reference to 
Primary GNSS Lever Arm)

GAMS Calibration Results

POSPac Display Calibrated Installation Parameters 

Two Antenna Separation (m)



ERDDM Acquisition Log
Vessel

3/13/2012
Date Dn Local Area Wx

Personnel

Comments

USCG DGPS Beacon Used

POS File Azmuth Vessel Speed RPM Start and End Time

125 04 670
125 06 1020 1817 start, 1822 end
306 06 800 1822 start, 1827 end
306 4.3 (at idle) 600 1827 start, 1832 end

125 08 1440 1838 start, 1843 end
306 08 1230 1843 start, 1848 end

125 010 1730

5 Minute Break

5 Minute Break
2011_068_2805.106, 107

2011_068_2805.107
5 Minute Break

2011_068_2805.105, 106

2011_068_2805.107, 108
2011 068 2805 108 109

Yaquina Bay

1812 start, 1817 end
2011_068_2805.100

2011_068_2805.103, 104
2011_068_2805.104, 105

Fort Stevens, WA - 287 kHz (100 BPS)Slack Observed at approximately 1900
Tidal Cycle Notes

2011_073_2805.100 - 111

1853 start 1858 end

POSMV filename(s)

Launch 2805 400kHz

2011_068_2805.101, 102

SS Abraham, ENS Smith, ENS Younkin

15-20Kt

2011_068_2805.102, 103

125 010 1730
306 010 1710

Processing Log

3/13/2012
Date Dn Personnel

Graph and Table Values compared with previous year

5 Minute Break

2011_068_2805.108, 109
2011_068_2805.109, 110

POS Files Processed in POS Pac Singlebase - P367 (Newport Airport)
Smartbase or Singlebase? Station used.

073 SS Abraham, ENS Smith, ENS Younkin

SBET Processed in Pydro Using the ERDDM Tool

1908 end2011_068_2805.110, 111

Documentaion Complete in DAPR Appendix

1858 start, 1903 end

See OPS/CST for updating HVF with new values

1853 start, 1858 end





  2808 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.004 0.685 n/a Scaler Distance 1.453 -0.682 -0.837 0.000 0.000
y 0.000 0.250 1.086 n/a -0.837 -0.682 0.000 0.000
z 0.000 0.477 3.637 -0.093 -3.160 -3.160 0.000 0.000

*IMU is Reference Point -0.123

Vessel Offsets for 2808 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2011 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.68151 RP to Waterline (m) IMU to x -0.68151 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.83666 z 0.093 Port Ant (m) y -0.83666 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.15974 (calculated) z 3.15974 z 0.00000 z 0.00000

MBES RP x 0.00351 IMU to x 0.00351 IMU (m) x, y, z 0.00000 Top of x -0.68151 Heave Pt m)   x 0.00000
Rcvr - Phase (m)      y 0.24969 Phase Ctr y 0.24969 2010 RP to Waterline (m) Port Ant (m)  y -0.83666 (by design) y 0.00000
Center z -0.47677 (calculated) z -0.47677 z 0.123 Top of x 0.77098 z 3.14844 z 0.00000

Stbd Ant (m)  y -0.83402
z 3.13235 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.07544
Bottom of Stbd Ant
(calculated) (m)  z 3.05935 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to x 0.00351 x 0.68502 x n/a x -0.68151 x 0.00000

Phase Ctr y 0.24969 y 1.08635 y n/a Scalar Distance 1.4526 y -0.83666 y 0.00000
z -0.47677 z -3.63651 z 0.093 z 3.15974 z 0.00000

Coord. Sys. x 0.00351 Coord. Sys. x 0.68502 Coord. Sys. x n/a Coord. Sys. x -0.83666 Coord. Sys. x 0.00000
CARIS y 0.24969 CARIS y 1.08635 CARIS y n/a Pos/Mv y -0.68151 Pos/Mv y 0.00000

z 0.47677 z 3.63651 z -0.093 z -3.15974 z 0.00000

IMU to 7125 (Receiver) Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(2010 used for K5K)

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)



Description of Offsets for Launch 2808

All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2808 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.4526 m Primary Antenna Reference Pt.

0.24969 m

7125 Phase Center

1.086 m

0.837 m
Primary Antenna Reference Pt.

0.685 m
7125 to Port Ant.

0 790

K5K Reference Pt.

3.15974 m

3 63651 m

0.004 m

IMU Reference Pt.

1.453 m

0.790 m
-0.564 m

3.63651 m

IMU Reference Pt
2808
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.47677 m

0.00351 m

7125 Phase Center

IMU Reference Pt.

2808
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0 68502 m

x y z x y z x y z x y z x y z
0.004 0.250 0.477 0.685 1.086 3.637 n/a n/a -0.093 -0.682 -0.837 -3.160 0.000 0.000 0.000

IMU to K5K

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave

Scalar Distance
1.453

IMU to 7125 Port Ant to 7125 RP to Waterline

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 

t t k hil

The values were calculated by 
subtracting the physical height of 
the of the Port Antenna to the 
IMU x, y, z values from the 
respective values of the IMU to

The average vertical distance 
from Port Benchmark to waterline 
and the Starboard Benchmark to 
the waterline were measured by 
FAIRWEATHER personnel using

The location of the IMU and the 
location of the top of port antenna 
were surveyed by NGS.  The z-
value of the antenna was 
calculated by subtracting the

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase

0.68502 m
7125 to Port Ant.

x y z
-0.564 0.790 0.777

IMU to K5K

the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

e o e o e a o e
IMU x, y, z values from the 
respective values of the IMU to 
the 7125.  The calculated values 
were then transposed from the 
NGS to the CARIS coordinate 
system.

a d e S a boa d e c a o
the waterline were measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were combined 
with the Z value of the 
Benchmarks to the RP/IMU to get 
an average for the waterline to 
RP.  The Waterline Measurement 
value is in NGS coordinates 
initially and is converted to 
CARIS coordinates.

value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base of 
the antenna to the phase center 
of the antenna. The calculation 
results were then transposed 
from the NGS to the CARIS 
coordinate system. 

surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

The location of the IMU and the 
location of the forward keel  
benchmark were surveyed by 
NGS.  BM to K5K were measured 
by FAIRWEATHER personnel 
using a steel tape and bubble 
level.

y using a steel tape and bubble 
level.



Fill in Yellow squares only!
Measuring Party:

Waterline measurements should be negative and cm!

Date: 3/14/2011
Fuel Level: 62.6 GAL (about 1/2 full)

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0316 -0.0240 -0.0556

Stdev

BM Z-value (m)* RP to WL Average (m)

BM to WL (m) 0.093 NGS Coordinate System (do not enter into CARIS directly)

(Add this value to VSSL_Offsets & Measurements_20XX.xls)
Individual 0.13300 0.06144
measurement 0.11800 0.07344

StDev for TPU xls 0.032 0.11100 0.06044   utilized in Offsets and Measurements and TPU spreadsheet

(of 6 #'s)

Measuring Party:

Date: 3/21/2011
Fuel Level: 100gal

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0316 -0.0257 -0.0572

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.106 NGS Coordinate System (do not enter into CARIS directly)

(or add this value to VSSL_Offsets & Measurements_20XX)
Individual 0.11400 0.07344
measurement 0.15500 0.08344
StDev for TPU xls 0.034079 0.13600 0.07644
(of 6 #'s)

1.04444

2808
Port Benchmark to Waterline

-92.1

2808

Francksen, Stuart, Pfundt, Smith

Francksen, Pfundt, Abraham

Waterline Measurements

-0.9410

0.01124 0.00723

-0.9667

1.07600

0.121

2808

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.065

-95.8 -97.1

Stbd Benchmark to Waterline

-94.3 -98.3

-98.4-96.5

-95.53

-0.9553

0.135 0.078

Waterline measurements should be negative and cm!

0.02052 0.00513

-94.0 -96.8

1.07600 1.04444

-94.10 -96.67

-96.1

-97.93

-0.9793

-96.2 -97.1
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NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2808.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 27th of 
January, 2010.  The weather was foggy then sunny with temperatures in the 40s to 50s.  
For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.001m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU. The resulting coordinates are reported in 
appendix A. 
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 

 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 
STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 
 
 
 
 
 
 



Appendix A 
 

Coordinate Report Launch 2808 
 
Pt Name      North(Y) East(X) UP(Z)  ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13282    -0.00186   -0.16518    IMUR  
Centerline Stern BM          -4.07730   0.01391    0.61506     CLS   
Centerline Bow BM    3.44544    0.01391    1.44047     BMB   
Portside GPS Ant. Ref. Point -0.83666   -0.68151   3.14844     GPSP  
Starboard GPS Ant. Ref. Point-0.83402   0.77098    3.13235     GPSS  
Multi-Beam Ref.Point    0.24969    0.00351    -0.47677    MB    
Keel BM      0.44021    -0.00126   -0.60545    MBF   
Keel BM        -0.22600   0.00192    -0.53583    MBA   
Port Side BM     0.08204    -1.42963   1.07600     BMP   
Starboard Side BM     0.08324    1.46250    1.04444     BMS   
 
Units = meters 
   
 
       
    
      
   
  
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Appendix B  

 
Point to Point Inverse Launch 2808 

 
Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
3    40   0.001   -0.001    0.000    0.00026    MBF 
5    42   0.003   -0.002   -0.001    0.00013    MBA 
4    41   0.002   -0.001   -0.002    0.00062    MB 
14   55   0.006   -0.005    0.004    0.00049    IMUR 
13   56   0.006   -0.004    0.004    0.00055    IMU 
43    6   0.001    0.000    0.001    0.00048    CLS 
33   44   0.000    0.000    0.000    0.00006    BMS 
8    22   0.001   -0.001    0.000    0.00039    BMP 
17   25   0.005    0.000    0.005    0.00011    BMB 
24   34   0.001    0.000    0.000    0.00049    GPSS 
23    7   0.000    0.000    0.000    0.00022    GPSP 
 
Units = meters 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/14/2012
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/14/2012
Date Dn Local Area Wx

Shilshole

1/26/2010Fixed Hull Mount

Applanix POS/MV   S/N:2560       IMU S/N:991

105

Launch 2808 200kHz

Smith, Marcus, Bowker

2009Hull Mounted

105

Reson 7125

1812023

3/28/2012

Shilshole

sunny, 3 kt wind, light chop

Bottom Type Approximate Water Depth

Personnel on board

Comments

1605 30
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1726 32
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

POSMV Filename(s)

47/40/25.89N 122/25/29.63W

Marcum, Smith, Marcus, Bowker

8 kt lines have noisy data

2012_121_2808.238-256

2012_121_160540.he

2012_121_172655.he 47/40/25.89N 122/25/29.63W



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

122 4.0
138 8.0
317 4.0
314 8.0

2012M_1051729 130 8.0
316 8.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

122 4.0
317 4.0
130 4.0
310 4.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

126 4.0
322 4.0
115 4.0

2012M_1051730

line 11, Noisy Data
Line 11

XTF Line Filename

Line 11

2012M_1051716

2012M_1051719
2012M_1051721

2012M_1051715

XTF Line Filename
2012M_1051713

Line 1
Line 13
Line 12

line 112012M_1051713

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2012M_1051726

Line 11

2012M_1051723
XTF Line Filename

Line 11

2012M_1051724

Line 11
Line 11

2012M_1051715
2012M_1051718

Line 11
line 11

306 4.0

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

234 4.0
060 4.0
239 4.0
058 4.0

Line 3

Line 2

2012M_1051737

_

2012X_1051925
2012X_1051928

2012M_1051728

XTF Line Filename
2012M_1051734

Line 3, purposely waked by 2805
Line 3, purposely waked by 2805
Line 3



Processing Log

4/14/2012
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -1.45 0.19 0.68
0.00 -1.65 0.18 0.58
0.00 -1.47 0.12 0.49
0.00 -1.50 0.17
0.00 -1.60 0.13

2012_105_2808_Concat.000.fixed

nearest in distance

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Faulkes

Beduhn
Loy
MacDonald

TrueHeave applied

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

105

Data converted --> HDCS_Data in CARIS

Faulkes

Zacharias

0.00 -1.53 0.16 0.58
0.00 0.09 0.03 0.10
0.00 -1.53 0.16 0.58

MRU Align StdDev gyro 0.10 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.06 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/15/2012Tami Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Resulting HVF File Name



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/30/2012
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/30/2012
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1605 30
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1726 32
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2012_121_172655.he 47/40/25.89N 122/25/29.63W

2012_121_160540.he

Launch 2808 400kHz

SS Brooks, SST Franksen, AST Marcus, PS Raymond

SST Franksen,AST Marcus, PS Raymond, SS Brooks

2009Hull Mounted

121

Reson 7125

2012_121_2808.238-256

1812023

3/28/2012

Shilshole

OVC, seas 2-3ft, wind 10-15Shilshole

1/26/2010Fixed Hull Mount

Applanix POS/MV   S/N:2560       IMU S/N:991

121

POSMV Filename(s)

47/40/25.89N 122/25/29.63W



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

132° 4.0
312° 4.0

2012M_1211637 132 4.0
2012M_1121639 312 8.0
2012M_1211641 132° 8.0

312 8.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

132 4.0
312 4.0

61° 4.0
241° 4.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

132 4.0
310 4.0
138 4.0
310 4.0
138 4.0
305 4.0
138 4.0

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

300 4.0
145 4.0

2012M_1211724 310 4.0

2012M_1211715

2012M_1211710
2012M_1211712

2012M_1211717

XTF Line Filename
2021M_1211720

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2012M_1211709

broke line due to set and buoy
half line due to set

2012M_1211702
XTF Line Filename

2012M_1211635

half line due to set

roll warning on line

2012M_1211722

swervy, low quality2012M_1211632.Hsx

2012M_1211652
2012M_1211655

2012M_1211649

XTF Line Filename
2012M_1211647

2012M_1211642

2012M_1211705



Processing Log

4/30/2012
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -1.20 0.26 0.39
0.00 -1.17 0.29
0.00 -1.10 0.27
0.00 -1.12 0.25 0.42

0.00 -1.15 0.27 0.41
0.00 0.05 0.02 0.02
0.00 -1.15 0.27 0.41

MRU Align StdDev gyro 0.02 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/15/2012

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

121

Data converted --> HDCS_Data in CARIS

Faulkes

Zacharias
Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Tami Beduhn

2012_121_2808_Concat 

zero tide

HSRR 2808_121 Nearest in distance in 3 hours

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Faulkes
Raymond



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 2808

Date: 3/28/2012 Dn: 088

Personnel: ENS Smith, SS Marcum, ENS Flowers

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 4.3.4.0

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:

Approximate Position: Lat 44 37 37

Lon 124 2 46

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 273 kHz

4624A70263

991

NOAA POS/MV Calibration Report

Yaquina Bay

2560

Ft Stevens

4624A70243

129.100.1.231

MV-320 V4 (BD950)

2012_088_2808.000
POSMV filename(s)

Frequency: 273 kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 2.1 (Use View> GAMS Solution)

Secondary GPS

N



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 1957

End time: 2026

Heading accuracy achieved for calibration: 0.049

Calibration Results:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

C:\HYPACK 2011\Projects\HSRR_2011\Raw\GNSS_Data\POSMV_Data



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2



COM3

COM4

COM5



SETTINGS Continued
Heave Filter Events

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)



Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement

IMU Frame Auxiliary GPS Measurement

U GAMS bl dUse GAMS enabled

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver



Secondary GPS Receiver

Processing Log

3/29/2012
Date Dn Personnel

Allow decimeter level freedom when processing

Reprocess using new values, but restrict to 10 cm of freedom

Reprocess using new values, again use 10 cm of freedom

Continue itterating until values no longer change

Post Processing of GAMS Calibration

089

POS Pac Processing

ENS Smith, ENS Flowers

See FOO/CST with values

Values

New Values entered in POS View?

Final Antena Seperation/ Lever Arms Determined



Date: 3/28/2012 Dn: 088

Vessel: 2808

(Project Settings > GNSS-Inertial Processor > Lever Arms and Mounting Angles)
X Y Z

-0.008 -0.031 0.130

X Y Z

-0.725 -0.72 -3.17

(W:\Control\HorCon\Pubs-Refs\Scripts\CalcOUTstats.py)
X Y Z

Run 1 -0.727 -0.718 -3.17
Run 2 -0.727 -0.718 -3.17
Run 3

1.453

GAMS CalibrationPost-Processing Results

POS File Name: 2012_088_2808.000

POSPac Project Name: 2012_088_2808_GAMS

Project Location: Yaquina Bay

Lever Arm Offsets

Reference to IMU Lever Arm

Starting Value (Reference to 
Primary GNSS Lever Arm)

GAMS Calibration Results

Trailing 10 Minute Average Using Pydro Macro 

Two Antenna Separation (m)



ERDDM Acquisition Log
Vessel

4/14/2012 105
Date Dn Local Area Wx

Personnel

Comments

USCG DGPS Beacon Used

POS File Azmuth Vessel Speed RPM Start and End Time

013 04
013 06
013 08 1330
013 010 1770
193 010 1740
193 08 1320
193 06 910
193 04 600

2012_105_2808.109
2012_105_2808.110

2012 105 2808 111 112

1814 start, 1819
2012_105_2808.104

2012_105_2808.106
2012_105_2808.106
2012_105_2808.107
2012_105_2808.108
2012_105_2808.109

1819 start, 1824

Shilshole

1829 start, 1834
1834 start, 1840

1849 start, 1856

1824 Start, 1829

SS Marcum, ENS Smith, AST Marcus, AST Bowker

0-1 ft chop

1808 start, 1814

Launch 2808 200kHz

2012_105_2808.105

1840 start, 1844
1844 start, 1849

1856 start 1901

Robinson Point, WA - 323 kHz (200 BPS)slack 1140 local time
Tidal Cycle Notes

POSMV filename(s)

5 minute wait

5 minute wait

Processing Log

4/15/2012
Date Dn Personnel

Graph and Table Values compared with previous year

POS Files Processed in POS Pac Smartbase - (P426, SEAI, RPT5, PRDY, KTBW)
Smartbase or Singlebase? Station used.

2012_105_2808.111, 112

106 ENS Smith

SBET Processed in Pydro Using the ERDDM Tool

Documentaion Complete in DAPR Appendix

See OPS/CST for updating HVF with new values

1856 start, 19015 minute wait





S220 Offsets and Measurements - Summary

Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 2.868 2.071 n/a Scaler Distance 1.997 0.797 -11.892 1.866 -7.028
y 8.252 20.144 n/a -11.892 0.797 -7.028 1.866
z 4.752 17.821 0.081 13.068 -13.068 -2.086 -2.086

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220 7111 are derived from Westlake Survey Report NOAA Fairweather 09-23-03, Fairweather Centerline Survey (NGS) Report March 2009, and measurements by FA personnel in 2010 and 2011.

Calculations

Coordinate Westlake NGS Westlake NGS NGS Westlake
Systems IMU easting 0.000 Top of IMU x -11.892 IMU Base to baseline at Keel Phase Center         x -11.892 IMU Top (m) x 0.000 IMU to Bulkhd (Frame) 52 IMU Base to baseline at Keel
used Base northing 0.000 to Port Ant y 0.797 (ft) elevation 12.856 Port Ant y 0.797 y 0.000 (ft) easting -11.638 (ft) elevation 12.856
as listed (ft/m) elevation 0.000 (m) z 13.068 IMU Base to baseline at Keel (m) z 13.068 z 0.000 (m) easting -3.547 (m) elevation 3.919

(m) elevation 3.919
8111 (from IMU Base to sensor) CARIS Frame 0 (FP) to Frame 52 Top of IMU to Base of IMU

easting 27.072 Port x 0.797 Waterline to Keel Top of old Stbd       x -11.886 Top of old Port           x -11.892 (m) easting -27.737 (m) elevation 0.168
(ft) northing 9.410 Ant y -11.892 (ft) elevation 13.67 Ant (pre-2010)        y 2.794 Ant (pre-2010)           y 0.797 Top of IMU to Keel

elevation 15.042 (m) z -13.068 Waterline to Keel (m) z 13.051 (m) z 13.047 IMU to Frame 0 (FP) (m) elevation 4.086
(m) elevation 4.167 (m) easting 24.190

8111 (from IMU Base to sensor) Westlake See Ship's Draft Spreadsheet Top to Base of Old (pre-2010) Ant Top to Base of Old (pre-2010) Ant Center of Gravity above baseline
easting 8.252 (m) easting 8.252 measured (in)     z 2.477 measured (in)        z 2.477 Heave Pt* to Frame 0 (FP) (ft) elevation 16.37

(m) northing 2.868 Top of IMU northing 2.868 Top of IMU to Base of IMU (m)     z 0.0629 (m)        z 0.0629 (ft) easting 102.42 Mean Metacentric height
elevation 4.585  to 8111 elevation 4.752 (m) elevation 0.168 (m) easting 31.218 (ft) elevation 3.88

Top of IMU to Keel
Base of IMU to Top of IMU CARIS (m) 4.086 Top of Stbd x -11.886 Top of Port x -11.892 IMU to Centerline Heave Pt* to baseline at Keel

(m) elevation -0.168 (m) x 2.868 Ant Post y 2.794 Ant Post y 0.797 (ft) northing 6.122 (ft) elevation 20.25
Top of IMU y 8.252 (m) z 12.988 (m) z 12.984 (m) northing 1.866 (m) elevation 6.172
 to 8111 z 4.752

2010 value -> Correction based on Ref Surface Base to Phase Ctr New(2010) Ant Base to Phase Ctr New(2010) Ant Heave Pt* to Centerline (*Heave Pt is Metacenter)
-0.322 (m) elevation 0 listed on Antm)        z 0.0843 listed on Ant (m)        z 0.0843 (m) northing 0 (FP is Forward Perpendicular)

Westlake easting 8.252 CARIS x 2.071 Westlake easting N/A NGS (m)     x -11.886 NGS (m)        x -11.892 Westlake easting -7.028
Top-IMU northing 2.868 y 20.144 Waterline northing N/A Top of IMU             y 2.794 Top of IMU y 0.797 Top-IMU to northing 1.866
to 8111 (m)elevation 4.752 (m) z 17.821 to IMU  (m) elevation 0.081 to Stbd Ant z 13.072  to Port Ant z 13.068 Heave Pt* (m elevation -2.086

(aka Stbd Ant Phase Center) (aka Port Ant Phase Center) (*see Description Tab)
Coord Sys. CARIS Coord Sys. CARIS Coord. Sys CARIS Coord Sys. POS/MV Coord. Sys. POS/MV

x 2.868 x 2.071 x N/A x -11.892 x -7.028
y 8.252 y 20.144 y N/A y 0.797 y 1.866
z 4.752 z 17.821 z 0.081 Scalar Distance (m) 1.997 z -13.068 z -2.086

Port Ant to Stbd Ant IMU to Port Ant

IMU to Heave

IMU to Port Ant

IMU to 7/8111

IMU to 7/8111 IMU to Port Ant

IMU to Heave

IMU to Heave

Measured Values

Port Ant to Stbd Ant

Port Ant to 7/8111 Waterline to RP*

Port Ant to 7/8111

IMU to 7/8111 (MRU to Trans) Port Ant to 7/8111 (Nav to Trans)

Waterline to RP*

Waterline to RP* Port Ant to Stbd Ant

Stbd Antenna



S220 Offsets and Measurements - Summary

Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.493 -0.304 n/a Scaler Distance 1.997 0.797 -11.892 1.866 -7.028
y 7.665 19.557 n/a -11.892 0.797 -7.028 1.866
z 4.726 17.794 0.081 13.068 -13.068 -2.086 -2.086

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S220 8160 are derived from Westlake Survey Report NOAA Fairweather 09-23-03, Fairweather Centerline Survey (NGS) Report March 2009, and measurements by FA personnel.

Derivations
Coord. Sys.

Westlake NGS 2009
IMU easting 0.000 Top of IMU x -11.892
Base northing 0.000 to Port Ant y 0.797

(ft/m) elevation 0.000 (m) z 13.068

8160 (from IMU Base to sensor) CARIS
easting 25.149 Port x 0.797

(ft) northing 1.619 Ant y -11.892
elevation 14.956 (m) z -13.068

8160 (from IMU Base to sensor) Westlake
easting 7.665 (m) easting 7.665

(m) northing 0.493 Top of IMU northing 0.493
elevation 4.559  to 8160 elevation 4.726

Base of IMU to Top of IMU CARIS
(m) elevation -0.168 (m) x 0.493

Top of IMU y 7.665
2010 value -> Correction based on Ref Surface  to 8160 z 4.726

-0.206 (m) elevation 0

Westlake easting 7.665 CARIS x -0.304
Top of IMU northing 0.493 y 19.557
to 8160 (m) elevation 4.726 (m) z 17.794

Coord Sys CARIS Coord Sys CARIS
x 0.493 x -0.304
y 7.665 y 19.557
z 4.726 z 17.794

IMU to 8160

IMU to 8160 (MRU to Trans)

IMU to 8160

Port Ant to 8160 (Nav to Trans)

Port Ant to 8160

IMU to HeavePort Ant to Stbd AntWaterline to RP*

Port Ant to 8160

IMU to Port Ant



S220 Offsets and Measurements - Summary

Measurement IMU 
aka to RP*
Coord. Sys. Caris Caris
x 0.000 1.866
y 0.000 -42.642
z 0.000 -7.402

*IMU is Reference Point

Vessel Offsets for S220 Tow Point are derived from Fairweather Centerline Survey (NGS) Report March 2009, and 2011 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000
NGS y 0.00000

z 0.00000

x -39.727
y 3.366
z 2.385

A-FRAME PIVOT STBD
 to TOW PT x -2.915
(measured) y -1.500

z 5.017

Coord. Sys.
NGS IMU to x -42.642

TOW PT y 1.866
z 7.402

Coord. Sys. x 1.866
CARIS y -42.642

z -7.402

A-FRAME PIVOT STBD (m)

IMU to TOW PT K5K

IMU to TOW PT K5K

IMU to TOW PT K5K



Description of Offsets for FAIRWEATHER S-220
All Values Shown are in CARIS Coordinates

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

IMU to Seabat 7111
x: 2.868
y: 8.252
z: 4.752

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

Scaler Distance 1.997

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.068

Port Antenna to 7111
x: 2.071
y: 20.144
z: 17.821

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.794

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.068

IMU to Tow Pt K5K
x: 1.866

y: -42.642
z: -7.402

IMU to Tow Pt K5K
x: 1.866

y: -42.642
z: -7.402

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.794

Port Antenna to 7111
x: 2.071
y: 20.144
z: 17.821

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

IMU to Seabat 7111
x: 2.868
y: 8.252
z: 4.752

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000



x y z x y z x y z
2.868 8.252 4.752 0.493 7.665 4.726 1.866 -42.642 -7.402

x y z x y z
2.071 20.144 17.821 -0.304 19.557 17.794

x y z
Scaler Distance 1.997 0.797 -11.892 13.068

x y z x y z From pg 3 of the Westlake Survey
n/a n/a 0.081 1.866 -7.028 -2.086

Relative positions obtained from 
Port Ant to 7/8111 via IMU.

Waterline to RP*

The height of the IMU above the 
keel comes from the Westlake 
survey value of 3.919 m plus the 
measured value of the top of the

Key points on the IMU, from the 
Westlake survey, are its location 
with respect to the ship’s 
reference frame It is 4 087 m

IMU to Port Ant

IMU to Heave

This information comes from a combination of the Westlake, 
NGS surveys, and measurements by FA personnel. The NGS 
2009 survey was to the top of the antenna, that distance (z-
value) was measured in 2010 and subtracted to get the xyz of 
the antenna post.  Then the distance (z-value) up to the phase 
center to the new 2010 antanna was added to obtain the xyz of 
the phase center of the newly installed (May2010) antenna.

IMU to 8160 (MRU to Trans)

The lever arms between the IMU 
and phase center of the 8160 
transducer are taken from the 
Westlake report with the addition 
of the -0.168 m offset included for 
the height of the IMU.  

Port Ant to 8160 (Nav to Trans)

The lever arms between the IMU 
and phase center of the 7111 
transducer are taken from the 
Westlake report along with the the -
0.168 m offset included for the 
height of the IMU.  

Port Ant to Stbd Ant

Using the NGS 2009 survey values 
for the antennas, a calculated 
vector for antenna separation was 
determined. The distance from Top 
of Antenna to Phase Center does 
not affect this calculation and 
therefore was not included.

IMU to Heave

IMU to 7/8111 (MRU to Trans)

Port Ant to 7/8111 (Nav to Trans)

IMU to TOW PT K5K

The offsets were determined using 
the NGS 2009 survey values for 
the A-Frame Stbd Pivot and 
measurements by FA personnel. 
Measurements between the A-
Frame Pivot and the Tow point 
were made with a steel tape and 
digital level to determine the 
deployed angle of the A-Frame. 

Relative positions obtained from 
Port Ant to 7/8111 via IMU.

IMU to Heave

measured value of the top of the 
IMU to the base plate, to get an 
IMU height above the keel.  The 
draft (waterline to keel) used for the 
FAIRWEATHER is based on 
observations, Ship's Draft 
spreadsheet.  Differencing the 
value of IMU to keel and waterline 
to keel gives the waterline to RP 
distance.  

reference frame.  It is 4.087 m 
(3.919 m to base line + 0.168 m 
for IMU height above base plate) 
above the keel, 1.866 m port of 
centerline and 3.547 m forward of 
frame 52.  This information is 
needed to reference the IMU to 
the ship’s Heave Measurement 
Location (Heave Point). *

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel.  From the 
Westlake survey, the IMU is located 3.547 m forward of frame 52.  From Inclination document, the HP is 31.217 m aft of the forward 
perpendicular.  From engineering drawings of the ship frame spacing is approximately 21 inches.  The calculation for the longitudinal location 
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.

31.217 m (HP aft of FP) – 24.190 m (IMU aft of FP) =  7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the 
height of the IMU being 4.087 m above the keel.  Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU 
is 1.866 m to port of the centerline.

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There 
may be a better way to determine the Heave Point, but this decision was based upon available information).  The metacenter is defined by 
the center of buoyancy.  As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is 
at the metacenter.  

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with 
respect to the vessel.  The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular.  The 
height of the metacenter is 20.25 feet (6.172 m) above the keel.  There is an assumption of the metacenter being on the centerline of the 
vessel.  Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel.  The difference 
in the height of the metacenter can be attributed to the difference between the FA’s and RA’s average draft which is 13.12 feet as opposed 
to approximately 14.5 feet respectively.

is 1.866 m to port of the centerline.



Sources

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:
Westlake Consultants, Incorporated
15115 SW Sequoia Parkway, Suite 150
Tigard, Oregon 97224
Phone (503) 684-0652

The relocation of the POS M/V antenna forced a partial resurvey in Feb-2007 by Steven Breidenbach of NGS (values no longer utilized).

While in drydock, another NGS (Centerline) survey was conducted March, 2009. 

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA  98337-1932

Calculations

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet.  The reference point and 
the IMU are identical.  Difference in documentation between Westlake and FA calculations are based off of measuring up from 
the IMU base (Westlake’s origin) and the top of the IMU.  The top center of the IMU for the POS/MV is the defined origin for 
the POS/MV and the origin that is being used on all FAIRWEATHER vessels.  The distance from the base plate to the top of the 
IMU is 0.168 m, a value measured by ship’s complement.  Conversions factor from feet to meters is 0.3048 m/ft.

As a requirement for the TPU, the standard deviation for each position is 3 mm.  This value is based upon a conversation with 
El i M D ld f W l k d i f ll d b E il d i h f Th il i l d h d f hi

Offset values for the ship were derived from three sources.  Three static offset surveys, an inclination experiment, and values measured or 
approximated by ship’s personnel.

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin.  All 
dimensions in the document are given in feet and decimal feet.  

Elaine McDonald of Westlake and is followed up by an Email documenting that fact.  The email is located at the end of this 
document.



2012 Fwd Aft slope IMU Depth (ft) IMU Depth (m)
x1 y1 x2 y2 Min Max

ave 40-45 Empty - Port 5.25 13.28 189 13.11 -0.00093 13.21 4.027 13.08 14.39
ave 40-45 Empty - Stbd 5.25 13.20 189 13.08 -0.00065 13.15 4.009
ave 90's Full - Port 5.25 13.53 189 14.39 0.00468 13.88 4.230
ave 90's Full - Stbd 5.25 13.56 189 14.14 0.00316 13.79 4.204

Description (ie empty, full) 5.25 189 0.00000 0.00 0.000

Draft at IMU (ft) 13.51 4.117 AVG Value Used in Offsets
The IMU x-value (ft): 79.36 0.380 0.116 STDEV Value used for Waterline Loading Uncertainty

x-value (m): 24.19                                                                                                                                                                                                                                                                         

Fairweather  Draft - 2012

Immediately prior to the FA field season, the draft measurements were taken prior to fueling when the tanks were 
very empty (Empty) . And again after fueling and once the engineers had transferred the fuel in a satisfactory manner 
(Full).  The waterline at the IMU was then calculated based on a linear interpolation.
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NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship of various 
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.  
Additionally, various reference points (bench marks) were re-established onboard the vessel to 
aid in future spatial surveys aboard the boat. 
 
 
PROJECT DETAILS 
 
This survey was conducted while the ship was in dry dock at the Lake Union dry dock in Seattle, 
WA.  The weather conditions over the two days required to conduct this survey were windy, 
cool, with intermittent rain.   
 
 
INSTRUMENTATION 
 
The Leica TC2003 total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 0.2mm + 2ppm 
 
A Leica precision prism was used as a sighting target.  This prism was configured to have a zero 
mm offset.   
 
 
PERSONNEL 
  
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
 Dennis Lokken           NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
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DEFINITION OF THE REFERENCE FRAME 
 
To conduct this survey a local coordinate reference frame was established where the Northing 
(Y) axis runs along the centerline of the ship and is positive from the IMU towards the bow of 
the ship.  The Easting (X) axis is perpendicular to the centerline of the ship and is positive from 
the IMU towards the right, when looking at the ship from the stern.  The Up (Z) axis is positive 
in an upward direction from the IMU.   
 
 
SURVEY METHODOLOGY 
 
02/15/2009 
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control point 1.  
A distance and height difference were measured between temporary control points 1 and 3.  
These values were used to determine the coordinates at temporary control point 3.  Temporary 
control points 1 and 3 were located along the top deck and on the north side of the dry dock 
vessel.   
 
Temporary control point 1 was occupied and temporary control point 3 was observed for a 
backsight.  After initialization, temporary control points 2 and 4(located on the top deck of the 
dry dock vessel), H1 (located on the bottom deck of the dry dock vessel), and BOW BM were 
observed in both direct and reverse. 
 
Temporary control point 2 was occupied and temporary control point 3 was observed for a 
backsight.  After initialization, temporary control point W1 (located on the top deck of the dry 
dock vessel) and D1 (located inside the ship on the D deck along the port side) were observed in 
both direct and reverse.  Temporary control point 1 was also observed and yielded an inverse 
check of 0.001m horizontally and 0.001m vertically. 
  
Temporary control point 4 was occupied and control point 1 was observed for a backsight.  After 
initialization, temporary control point 5 (located on the south side and on the top deck of the dry 
dock vessel) was observed in both direct and reverse.  
 
Temporary control point 5 was occupied and control point 4 was observed for a backsight.  After 
initialization, temporary control point D2 (located inside the ship on the D deck along the 
starboard side) was observed in both direct and reverse. 
 



Temporary control point H1 was occupied and control point 1 was observed for a backsight.  
After initialization, temporary control point H2 (located on the bottom deck of the dry dock 
vessel), and USBL BM were observed in both direct and reverse. 
 
Temporary control point H2 was occupied and temporary control point H1 was observed for a 
backsight.  After initialization, 8111 BM and 8160 BM were observed in both direct and reverse.  
Temporary control point W1 was also observed and yielded an inverse check of 0.019m 
horizontally and 0.033m vertically. 
 
Temporary control point D1 was occupied and temporary control point D2 was observed for a 
backsight.  After initialization, temporary control point D3 (located in the doorway leading to the 
mess hall on the D deck) was observed in both direct and reverse.   
 
Temporary control point D3 was occupied and temporary control point D1 was observed for a 
backsight.  After initialization, temporary control point C1 (located on the C deck near the IMU) 
was observed in both direct and reverse.  Temporary control point D2 was also observed and 
yielded an inverse check of 0.026m horizontally and 0.0001m vertically. 
 
Temporary control point C1 was occupied and temporary control point D3 was observed for a 
backsight.  After initialization, IMU, IMU BOW PORT CORNER, IMU BOW STAR CORNER, 
IMU STERN STAR CORNER, and IMU STERN PORT CORNER were observed in both direct 
and reverse. 
 
02/16/2009 
 
Temporary control point 4 was occupied and control point 1 was observed for a backsight.  After 
initialization, temporary control point 6 (located on the south side and on the top deck of the dry 
dock vessel) and BOW BM were observed in both direct and reverse. Temporary control point 
D2 was also observed and yielded an inverse check of 0.0004m horizontally and 0.083m 
vertically. 
 
Temporary control point 6 was occupied and temporary control point 4 was observed for a 
backsight.  After initialization, TRANSOM PIVOT POINT PORT, STERN BM, POS GPS ANT 
RAIL BM, POS IMU ANT DECK BM, POS GPS ANT STARBOARD, and POS GPS ANT 
PORT were observed in both direct and reverse. 
 
Temporary control point 3 was occupied and temporary control point 1 was observed for a 
backsight.  After initialization, TRANSOM PIVOT POINT STARBOARD, STERN BM, POS 
GPS ANT STARBOARD, and POS GPS ANT PORT were observed in both direct and reverse. 
Temporary control point 6 was also observed and yielded an inverse check of 0.0006m 
horizontally and 0.001m vertically.  
 
The reference frame was rotated using STERN BM as the point of rotation.  A zero degree 
azimuth was used during the rotation from STERN BM to BOW BM. The reference frame was 
then translated to relocate the origin of the reference frame to the IMU. 
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INVERSE RESULTS 
 
Inverses were computed between the determined positions of those ship benchmarks and 
sensor points which were determined from two separate locations  The results of these inverses 
are: 
 
ID    Horizontal Dist.(m) Elevation Diff(m) 
BOW BM    0.0150    0.0240 
STERN BM    0.0060    0.0010 
POS GPS ANT STARBOARD  0.0100    0.0001 
POS GPS ANT PORT   0.0100    0.0000 
 
 
DISCUSSION 
 
The Fairweather was in dry dock during this survey, however, the dry dock vessel was still 
subject to movement due to wave action.   Conducting a survey such as this while the ship is 
moving requires that the automatic compensators in the survey instrument be turned off.  The 
survey is therefore conducted with all survey instrumentation set up relative to the mean 
movement of the related level vials.  While every effort was made to make the most precise 
measurements possible, some additional error accumulation cannot be avoided under these type 
observing conditions.   
 
The POS GPS antenna coordinates were determined to the top center of the antennas.  The Z 
value should be corrected to the Antenna Reference Point (ARP).  In order to apply this 
correction, the mechanical height of the antenna should be determined and subtracted from the Z 
value determined during this survey for both of the POS GPS antennas. 
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Coordinate Listing using IMU as the Reference Frame Origin  
 
 

ID  X(NORTHING)m Y(EASTING)m  Z(UP)m 

IMU CENTER  0.000 0.000 0.000 
IMU STERN PORT CORNER  ‐0.071 ‐0.089 ‐0.001 
IMU BOW PORT CORNER  0.070 ‐0.086 ‐0.001 
IMU BOW STARBOARD CORNER  0.069 0.087 0.000 
IMU STERN STARBOARD CORNER  ‐0.073 0.086 0.000 
BOW BM  28.378 1.805 7.796 
STERN BM  ‐40.306 1.805 2.255 
USBL BM  ‐28.354 1.738 ‐4.204 
8160 BM  8.407 0.395 ‐4.400 
8111 BM  8.532 3.002 ‐4.666 
POS GPS ANT RAIL BM  ‐12.011 1.785 10.381 
POS IMU ANT DECK BM  ‐11.790 1.780 9.305 
POS GPS ANT STARBOARD  ‐11.886 2.794 13.051 
POS GPS ANT PORT  ‐11.892 0.797 13.047 
TRANSOM PIVOT POINT STARBOARD  ‐39.727 3.366 2.385 
TRANSOM PIVOT POINT PORT  ‐39.722 0.240 2.345 
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IMU Reference Points 
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POS GPS ANTENNAS 
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CENTERLINE REFERENCE POINT ON G DECK 
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CENTERLINE REFERENCE POINT ON RAIL AT G DECK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 

 
 

CENTERLINE STERN REFERENCE POINT 
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TRANSOM REFERENCE POINT ON PORT SIDE 

 

 
TRANSOM REFERENCE POINT ON STARBOARD SIDE 
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8111 REFERENCE POINT 
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Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings 

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.
Negative values are port of the IMU.
Calculated values are in italics.

Eastings 

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU. 
Negative values are aft of the IMU.
Calculated values are in italics.

Elevations  

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation. 
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions 

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data 

At project initiation, control was established to define the ship's centerline 
as a plane running from a point on the centerline of the keel at the stern through a 
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock. 

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry. 
Following location of the IMU, data was transformed to the IMU as point of origin for 
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."

Page 1 of 11 Pages
Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls

Report of Sonar Array
Installation on

NOAA Fairweather



Westlake Consultants, Inc.
9/23/2003

Ship's Centerline - Control Measurements 
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Defined by measurements at the keel centerline 
longitude transverse elevation

near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180' forward) 1180.121 1000.000 116.6810

Ship's Baseline

Defined by measurements on the keel 
longitude transverse elevation

at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022
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Westlake Consultants, Inc.
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IMU Foundation Plate
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines 
on IMU foundation plate 0.001

0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *
0.001

-0.001
0.000

-0.001

SUMMARY 
•  IMU foundation plate is level to within +/-0.001 feet.
•  IMU foundation plate is located 12.856 feet above baseline established at the keel.
•  IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
•  IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52. 

* elevation check adjusted for target 
that created 10 mm offset =.03281 

feet
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Westlake Consultants, Inc.
9/23/2003

Granite Block 
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines
1.584
1.583

Scribed lines - intersection/centerline of granite block 
-0.003 1.583

Deviation
Elevation checks near four corners of granite block from level

-0.217 -0.001
-0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY 
•  Granite block is level to within +/-0.001 foot 

of average elevation = -0.21632 feet
•  Granite block is parallel to ship's centerline to within  0.001 foot 

Location is  4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
•  Granite block is aligned with IMU to within 0.003 feet longitudinally. 

* elevation check adjusted for target that created 10 
mm offset = 0.03281 feet
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Array Acoustical Centers - Referenced to IMU 

EASTING NORTHING ELEVATION

PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the 
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)

27.008 Forward edge of foundation as measured 
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array 
25.149 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation. 

1.369 Port edge of foundation  as measured 
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General 
 + 0.172 Distance from bolt hole centerline to array center 

1.619 feet starboard of IMU

Elevation 
Per Reson drawing 2148M011_001  the elevation is 83 mm below array mounting surface

14.679 Array foundation elevation as measured. 
  0.005 Isolation "shim" added between foundation and array 
  0.272 83 mm below array mounting surface to acoustical center 
14.956 feet below IMU 
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Array Acoustical Centers - Referenced to IMU 
EASTING NORTHING ELEVATION

STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes. 
The elevation is defined as the center of the receiving array. 

Easting
Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation

28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated 

 - 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
 - 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.

9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation 
Elevation is 0.401 feet above receiver array mounting surface

16.085 Mounting foundation fixture plate as measured. 
15.447 Receiver foundation elevation - as calculated 

 + 0.005 Isolation "shim" added between foundation and array 
 - 0.410 Design distance from mounting surface of array to acoustic center 
15.042 feet below IMU 
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Westlake Consultants, Inc.
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Longitudinal Array Foundation - Port Side 
EASTING NORTHING ELEVATION

Horizontal alignment measured  at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated  to array centerline 
1.619
1.619

deviation from 
Elevation checks near four corners of array foundation level (average)

14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002

SUMMARY 
•  Port longitudinal array foundation average elevation is 14.679 feet.

Variation in elevation is +0.002 to -0.002 feet.
•  Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.

Calculated array centerline is 1.619 feet starboard of IMU 

Foundation edge is 0.25 feet port of 
array centerline
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Longitudinal Array Foundation - Starboard Side 
EASTING NORTHING ELEVATION deviation from 

Horizontal alignment measured  on fixture plate scribe - parallel
9.410 0.002
9.406 -0.002

Forward edge of array foundation fixture plate - measured
28.563

deviation from
Elevation checks near four corners of array foundation "fixture plate" average

16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations
Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY 
•  Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.

Deviation from level (average elevation) is less than 0.001 feet. 
•  Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.

Variation from parallel is from -0.002  feet to +0.002 feet from average. 
•  Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU. 

Design location is 3.292 feet 
starboard of ship centerline 
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Port Side
EASTING NORTHING ELEVATION

Forward Edge - Transverse array foundation - measured
28.343
28.338

Port edge - Transverse array - measured
-0.181

Centerline of array - calculated  
28.093
28.088

Port edge of foundation plus 1.806 feet 1.624
to calculated array centerline 

deviation from 
Elevation checks near four corners of array foundation level

14.679 0.002
14.675 -0.001
14.675 -0.001
14.677 0.001

SUMMARY 
•  Transverse array foundation average measured elevation is 14.677 feet 

below IMU (0.006 feet above design location).
Deviation from level (average elevation) is 0.003 to -0.001 feet

•  Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average). 

•  Transverse array centerline is calculated to be 1.624 feet starboard of IMU. 

Foundation forward edge minus        
0.25 feet to array centerline

0.861 feet below baseline with 0.965 
foot offset = 98.180 feet average 
elevation

Page 9 of 11 Pages
Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls

Report of Sonar Array
Installation on

NOAA Fairweather



Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered bo
transmitter and receiver foundations. The data provided here is primarily "calculated".

EASTING NORTHING ELEVATION

Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563

as measured 
Transmitter  (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate 
as measured - forward portion of plate
(near receiver array)
Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations
Receiver/Transducer Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263
Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY
•  Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation 

of 16.085 feet.  Deviation in elevation measurements across the  array fixture plate is less than 0.001 fe
•  Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.
•  Transverse array centerline is measured to be 9.406 feet starboard of IMU. 

Variation from parallel of the fixture plate across entire starboard array is ± 0.002  feet (from average). 
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Westlake Consultants, Inc.
9/23/2003

Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283

Foundation Plate Stack Antenna Alignment 7.677
Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.411
Port GYRO Foundation Plate Alignment 2.411

Stbd GYRO Foundation Plate Alignment 3.866
Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY
•  Foundation plate stack antenna alignment is parallel to ship's centerline.
•  Port GYRO Foundation Plate is aligned parallel to ship's centerline.
•  Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.

Page 11 of 11 Pages
Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls

Report of Sonar Array
Installation on

NOAA Fairweather



FAIRWEATHER

Multibeam Echosounder Calibration
Vessel

4/20/2012
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/20/2012
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Applanix POS/MV   S/N:3627      IMU S/N:292

S220 7111

2000-2400  Francksen, Bowker; 0000-0400 Faulkes, Robinson

~5/1/2009 TPUHull Mounted

111

7111

2009003

4/19/2012

Shilshole Bay

cloudy, choppy, rainyShilshole Bay

9/23/2003 and 2/15/2009Fixed Hull Mount

111

yp pp p

Personnel on board

Comments

~2200

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

0849
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2000-2400  Francksen, Bowker; 0000-0400 Faulkes, Robinson

Patch test was not completed because of a barge on the bouy.

2012_111_S220, 2012_111_S220_ERDDMa
POSMV Filename(s)

BOT_0002 47/43/46.55N 122/29/39.42W



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

271 4, 6
100 6, 4
274 8.0
100 8.0
271 10.0
098 10.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

271 4, 6
100 6, 4
274 8.0
100 8.0
271 10.0
098 10.0
230 4.0
230 5.3

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

050 4.0
230 4.0
050 4.0
050 4.0

1110814

1111750

1110814

1110743
1110757

1110827

1110714

XTF Line Filename
1110652

1110827

1110652

1111644

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

1111426

1111722

1110714

150/45 rpm

1110743
1110757

logged through turn 1111359
XTF Line Filename

1111411

160/50 rpm

230 4.0
050 4.0
050 4.0

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

050 4.0
230 4.8

1110403 050 5.0
1110414 230 6.0
1110433 230 4.8

stopped for 20 minutes for barge to locate

1110353

1111711
1111655

XTF Line Filename
1110339

15 m off line

40 m off line (use not recommended)



Processing Log

4/24/2012
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.01 -0.43
0.00 -0.28 -0.03
0.00 -0.03 -0.31
0.00 -0.40 -0.01 -0.38

all 7 files

N395FA2010CORP.zdf

preliminary

NIDWT 4hrs

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Zacharias
Faulks

115

Raymond
Beduhn

TrueHeave applied

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

Beduhn

0.00 -0.34 -0.02 -0.38
0.00 0.08 0.01 0.06
0.00 -0.34 -0.02 -0.38

MRU Align StdDev gyro 0.06 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.05 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/25/2012Tami Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Resulting HVF File Name



FAIRWEATHER

Multibeam Echosounder Calibration
Vessel

6/13/2011
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

6/13/2011
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

164

S220 8160

Moehl, Bravo

Moehl, Bravo

2004Hull Mount S220

164

RESON 8160

35385Unknown

Kodiak, Marmot Bay

Hull Mount

20-100m

Applanix POS/MV v.4

Cldy, Seas <1ftMarmot Bay, Kodiak Island

Comments

TrueHeave filename

SV Cast #2 filename UTC Time Lat Lon Depth

2011_164_S220.000



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

273 4.2
093 3.8
273 4.1
093 4.1
273 4.6
090 4.2

0 4.0
180 4.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

090 5.3
270 5.0
090 4.3
270 4.5

XTF Line Filename

XTF Line Filename

XTF Line Filename
2011S_1641642
2011S_1641657
2011S_1641706

2011M_1641835
2011M_1641855

2011S_1641721

2011M_1641905

2011S_1641741

15m west

Bad line heading east, missed feature

Bad line heading east, hit feature on nadir, but…
2011S_1641732

2011S_1641759
2011S_1641812
2011S_1641824

Not on line, 25m east

Use Roll Lines

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

0 4.8
180 5.0

2011M_1641915
2011M_1641928

XTF Line Filename



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: S220

Date: 4/19/2012 Dn: 111

Personnel: Beduhn, Arnold, Robinson, Bowker

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:

Approximate Position: Lat 47 59 48.17N

Lon 122 40 31.98W

DGPS B St ti DGPS R i S i l#

2012_111_S220_GAMS.000
POSMV filename(s)

3627

R bi Pt

1440904133

129.100.1.231

31180200

292

NOAA POS/MV Calibration Report

Oak Bay, Puget Sound

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 323

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.826-2.514 (Use View> GAMS Solution)

Secondary GPS

N

Robinson, Pt



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 2245

End time: 2316

Heading accuracy achieved for calibration: 0.469

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name: 2012_111_S220_GAMS.000

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

NoneNone

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC

$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select

None



COM3

Baud Rate Rate Parity Data Stop

Output Select

None

Input Select Input

? Input Type

Line

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config) Can't Open

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Processing Log

Date Dn Personnel

See FOO/CST with values

Values

Allow decimeter level freedom when processingPOS Pac Processing

Reprocess using new values, but restrict to 10 cm of freedom

Reprocess using new values, again use 10 cm of freedom

Continue itterating until values no longer change

Final Antena Seperation/ Lever Arms Determined

Post Processing of GAMS Calibration

ENS Witmer

New Values entered in POS View?



Processing Log

6/13/2011
Date Dn Personnel

TrueHeave applied

SVP applied

Can't process the cast files with the new configs

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.19 -0.12 * -0.04
0.00 -0.30 -0.05 -0.10
0.00 -0.63 -0.57 * -0.30
0.00 0.11 -0.10 -0.74
0.00 -0.52 -0.04 -0.44
0.00 -0.25 -0.02 -0.20

2011_164_S220_Patch.000

Kodiak project

P136FA2011CORP.zdf

BOT0000.svp NIDWT 3

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Moehl
Eisenberg
Faulkes
Francksen
Froelich
Morgan

Data converted --> HDCS_Data in CARIS

Moehl, Bravo164

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

0.00 -0.30 -0.05 -0.30
0.00 0.26 0.21 0.26
0.00 -0.30 -0.05 -0.30

Resulting HVF File Name

MRU Align StdDev gyro 0.26 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.23 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 6/23/2011CST Morgan

Final Values based on

Averages
Standard Deviation

FINAL VALUES

FA_S220_Rsn8160_5to750_2011.hvf

Averages for Pitch and Yaw; Average with two values removed for Roll*.

*Value for Roll did not use the outlier nor the -0.12 value to determine patch value for use in the hvf, though all the values for Roll were retained 
for the Standard Deviation calculation.



ERDDM Acquisition Log
Vessel

5/10/2012 131
Date Dn Local Area Wx

Personnel

Comments

USCG DGPS Beacon Used

POS File Azmuth Vessel Speed RPM Start and End Time
drifting ~1.5 ---
276 ~4.5 140/40
094 ~4.5 140/50
drifting ~.5-1.5 ---
270 ~6.5 160/50
090 ~6.0 160/60
drifting ~0.5-1.5 ---
270 ~8.5 175/60
090 ~8.0 (9.0tw) 175/70
drifting ~.1-1.0 ---
270 ~10.5 180/75

POSMV filename(s)

S220 8160

1125 -> 1131

some currents (east direction required a little more engine order) 

Zacharias

clear and calm

Robinson Point, WA - 323 kHz (200 BPS)
Tidal Cycle Notes

2012_131_S220_ERDDM.000

1156 -> 1201
1204 -> 1209

1225 -> 1231
1233 -> 1238

1049 -> 1054

REST

1119 -> 1125
REST

Port Madison

1137 -> 1142
1150 -> 1156

1216 -> 1224

1059 -> 1104
REST

REST
270 10.5 180/75
090 ~9.5 180/80
drifting ~2 ---

Processing Log

5/13/2012
Date Dn Personnel

Graph and Table Values compared with previous year

See OPS/CST for updating HVF with new values

1251 -> 1258

Documentaion Complete in DAPR Appendix

REST

1233 > 1238
1245 -> 1251

ENS Witmer

SBET Processed in Pydro Using the ERDDM Tool

POS Files Processed in POS Pac Smartbase
Smartbase or Singlebase? Station used.













Appendix III 
 
 
Total Propagated Uncertainty (TPU) 
 
      Fairweather TPU Values 
 
 



Vessel FAIRWEATHER-S220 FAIRWEATHER-S220
Sonar System Reson 7111 Reson 8160
Frequency 200kHz 400kHz 200kHz 400kHz

MRU to Trans X 2.868 0.493
MRU to Trans Y 8.252 7.665
MRU to Trans  Z 4.752 4.726
Nav to Trans X 2.071 -0.304
Nav to Trans Y 20.144 19.557
Nav to Trans Z 17.821 17.794
Trans Roll 0.00 0.00

Vessel FAIRWEATHER-S220 FAIRWEATHER-S220
Sonar System Reson 7111 Reson 8160
Frequency 200kHz 400kHz 200kHz 400kHz

Status
Motion Gyro (deg) 0.02 0.02 Finalized
Heave% Amp 5 5 Finalized
Heave (m) 0.05 0.05 Finalized
Roll (deg) 0.02 0.02 Finalized
Pitch (deg) 0.02 0.02 Finalized

Offsets

Reson 7125 
2805

0.004

Version          
2012

Process Owner    
Survey

Last update        
October 1, 2012

POS/MV          
Model 320 V4

POS/MV          
Model 320 V4

Motion 
Sensor

Offsets

FAIRWEATHER SURVEY

Documents Title                       
FA_TPU_Values_2012

POS/MV          
Model 320 V4

                
Appendix III

2805
Reson 7125 

POS/MV         
Model 320 V4

Standard Deviation

Positioning System POS/MV          
Model 320 V4

Positioning System

0.245
0.482
0.686
1.051
3.656
0.000

0.04
5

0.05
0.02
0.02

POS/MV         
Model 320 V4

0.685

Effective Date     
April 1, 2012   

2808
Reson 7125 

POS/MV         
Model 320 V4

0.004
0.250
0.477

1.086
3.637
0.000

2808
Reson 7125 

POS/MV         
Model 320 V4

0.04
5

0.05
0.02
0.02( g)

Position Nav (m) 0.5* 0.5 Finalized
Vessel Speed (m/s) 0.03 0.03 Finalized
Timing Trans (s) 0.005 0.005 Finalized
Nav Timing (s) 0.005 0.005 Finalized
Gyro Timing (s) 0.005 0.005 Finalized
Heave Timing (s) 0.005 0.005 Finalized
Pitch Timing (s) 0.005 0.005 Finalized
Roll Timing (s) 0.005 0.005 Finalized
Offset X (m) 0.007 0.007 Finalized
Offset Y (m) 0.007 0.007 Finalized
Offset Z (m) 0.008 0.008 Finalized
Loading 0.128 0.128
Draft (m) 0.128 0.128
DeltaDraft (m) 0.10 0.10
MRU alignStdev gyro 0.06 0.26 0.27 0.10 0.10 0.02
MRU align roll/pitch 0.05 0.23 0.12 0.07 0.06 0.03
Tide Meas (m) 0.01 0.01 Project Dependent**
Tide Zoning (m) Project Dependent Project Dependent Default=0.2, Project Dependent**
SV Meas (m/s) 0.5 0.5 Defaults, Project Dependent**
Surface SV (m/s) 0.5 0.5 Defaults, Project Dependent**

*Position Nav adjusted in the HVF to 5m when acquiring in Coarse Acquisition mode, additional information will be submitted in the DAPR and/or the DR.
**Default values listed, descriptive report will list actual values applied if supplied with Project Instructions or calculated with the Sound speed estimator.
^MRU values may change if new patch test values are used.

MRU 
Alignment

Sound 
Velocity

Tides

Vessel 
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